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1 Introduction 
This is the reference manual to the EDMopenSimDM application. The reference manual lists all available 

functionality. In addition to this reference manual there is a Usage Guide; it is recommended to read the 

Usage Guide first to understand the use cases of EDMopenSimDM. 

EDMopenSimDM is a client desktop application that communicates via web-services with the 

EDMopenSimDM server. The client is also called “SimDM browser”. The application fulfills the 

following purposes: 

• Management of design and engineering analysis data 

• Product structure driven file management 

• Resource allocation 

• Collaboration and communication 

• Separation of responsibilities 

• Creation of a multi-disciplinary AP209 product model (federated model) 

• Graphical display of design, engineering, and testing data 

• Textual queries into AP209 product models 

• Archival of data packages 

• Supply chain management via dedicated web-client functionality. 

2 Terms and definitions 
AP209 ISO 10303-209:2014, Industrial automation systems and integration — 

Product data representation and exchange — Part 209: Application 

protocol: Multidisciplinary analysis and design 

Collection folder an EDMopenSimDM PBS-folder (master model node) that does not 

represent an AP209 sub-model itself, but that contains one or several 

such sub-models – directly or in sub-folders one level down, each with 

its own folder icon. Collection folders cannot exist without contents and 

cannot be created by the user. 

EDM EXPRESS Data Manager™ 

EXPRESS Data modeling language, defined in ISO 10303-11 

Gage definition a data set that describes gages and their location and orientation relative 

to a finite element mesh 

GDF Gage definition file 

Federated model a data instance model that consists of several interconnected sub-models 

ISO 10303-11 Industrial automation systems and integration — Product data 

representation and exchange — Part 11: Description methods: The 

EXPRESS language reference manual 

Link model a data instance model with relationship instances that connect different 

sub-models with one another. The link model is part of the AP209 

federated model. 
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P21 ISO 10303-21:2016, Industrial automation systems and integration — 

Product data representation and exchange — Part 21: Implementation 

methods: Clear text encoding of the exchange structure 

PBS Product Breakdown Structure 

Product model a collection of data instances, which in this context are organized in 

accordance to AP209, and that is structured into sub-models that 

together constitute a “Federated model” 

SimDM Simulation Data Management  

Sub-model one of the constituents of a federated model that typically resulted from 

a P21 import  

Test case the event of a structural test of a test part that is based on a test definition 

and results in a test result data set 

Test definition the specification of a test case with information of load cases and gage 

configuration 

 

3 Login dialog 
After start of the SimDM browser its main window is opened, and the “Login to EDMopenSimDM 

server” dialog appears (see Figure 1). 

 

Figure 1. Login dialog 

The “Server:” dropdown list contains predefined names of server connections. Connection parameters 

can be added or changed in the "Servers" dialog when the "Edit server list" button is selected. 
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Figure 2. Dialog to manage server connections 

By default, connection settings point to the following local URL of the SimDM web server: 

http://localhost:8080/EDMWS 

If the “Cancel” button is clicked, the dialog disappears, and no access is given to the system. It is possible 

to launch the dialog again by the “Server” → “Login” menu item. 

Click the “Login” button to get access to the selected server. 

 

Some servers require secure connections, that is, the URL of the connection starts with HTTPS. 

In this case it is recommended that the server has a SSL certificate, signed by a certificate authority or 

certification authority (CA). Only then the client will consider such SSL certificate as trusted. 

The server may have a self-signed SSL certificate. In this case the client cannot consider such SSL 

certificate as trusted by default. Therefore, the following dialog (see Figure 3) will appear. 

 

Figure 3. Warning about untrusted secure connection. 

The certificate can be viewed by clicking the button with yellow triangle. Then the user decides whether 

to trust the certificate. If so, the certificate needs to be installed in the system by clicking the button 

"Install certificate". 
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At the next login, the "Untrusted Connection" dialog will not appear if the certificate was installed as 

described above. 

4 Main window 
The main window of the application looks like in Figure 4 (left and right panel containers have open 

panels).  

 

Figure 4. Main window 

The SimDM browser has a dual panel user interface. Such user interface is based on the orthodox file 

manager (OFM) principle, also known as Commander-like file managers, the family of file managers 

based on the venerable Norton Commander interface. As opposed to file managers, the SimDM browser 

serves not only the functionality to work with files; also other types of information are managed, such as 

product structures, persons, organization and approvals. These data and their corresponding functionality 

are grouped into different types of panels. 

Panels are grouped into two panel containers: left and right. Many panels can be open at the same time, 

but each panel container shows only one panel at a time. Panel positioning is controlled by the buttons 

to the right of the “help” menu entry. It is possible to switch between panels in the panel container; use 

“Show open panels list” button (down-arrow) on the tool bar of the panel container for that. A panel can 

be moved into the opposite panel container or closed (deleted from both panel containers). And, the two 

panel containers can be organized so that only one of them is visible; that is, a single panel may take your 

entire screen. 

4.1 Main menu 
The main menu (see Figure 4) contains the following menu items: 

Server 

• Login – “Login” dialog appears (see chapter 2), the same as at system start-up. 

Main menu 

Status bar 

Toolbar to manage panels 

Left panel caption 

Right panel caption 

- Button to move right panel to left 

- Button to get list of open panels 

in right panel container 

- Button to close window on right 

panel 
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• Logout – closes the current session. 

• Change password… – changes password for the current user. 

• Export models – All available Product structures are exported to its own zip archive on the server side. 

• Exit – shuts the application down. 

 

View 

• Repositories and models – opens the “Repositories and models” panel or brings the open one to the 

front (see chapter 5.1) 

• User management – opens “User management” panel. The menu item is available for “superuser” 

only. See chapter 7 for details. 

• Local File Explorer – opens a “Local file explorer” (see chapter 5.2); several clicks open several 

explorers 

• CAX viewer – opens a panel with VCollab Presenter (geometry and analysis viewer) (see chapter 13) 

• StatusBar – opens and closes the status bar (see Figure 4) 

• Customize… - adapts appearance of panels, menus and commands to your personal preferences 

• Left Panel List – shows the list of opened panels in the left panel container 

• Right Panel List – shows the list of opened panels in the right panel container 

 

Tools 

• File associations – opens “File associations” panel or brings the open one to the front (see chapter 5.5) 

• Find in product structure… - opens “Find” panel for selected “PS browser” panel. 

 

Window 

Presents a list of all opened panels, both of left and right panels. 

 

Help 

• About – opens window with SimDM system information 

• Open User’s Guide – opens “EDMopenSimDM Reference Manual” using system default viewer. 

5 Panels 
The five types of panels are introduced in the following paragraphs. The “Server content”, “Local file 

explorer” and “CAX viewer” panels can be opened by entries in the “Views” menu item. The following 

operations can be done with all types of panels: 

• Move current panel to the opposite (left or right) side. 

• Retrieve list of available (opened before) panels in the left or right panel container1. The appropriate 

panel is shown when it is selected from the list. 

• Close current panel. 

These three operations are available in the right (and left) panel captions as three buttons (see Figure 5). 

 
1  This operation can be performed by using hot keys (Alt+F1 – for the left panel container, Alt+F2 – for the right 

panel container). 



EDMopenSimDM™ Application Reference Manual, R17 

 

2022-06-01  Page 20 

 

 

Figure 5. Panel operations 

 

5.1 Repositories and models 
The “Repositories and models” panel displays repositories and models in the SimDM database. At system 

start it appears on the left side. Each model represents a self-contained Product Structure (PS). References 

across model boundaries are not supported. 

Note: The default server-side installation includes the test data model “Ultralight_Glider” in repository 

“InitialRepository”. 

5.2 Local file explorer 
This panel represents the file structure on the local client machine as a tree. It is possible to Drag-and-

drop files between “Local file explorer” and “Product Structure browser” panels. 

Note: The “Windows Explorer” application can be used instead of the “Local file explorer” panel. But it 

is only possible to drag one (or several files) from “Windows Explorer” and drop it into the “Product 

Structure browser” panel, not vice versa. 

5.3 File associations 
The “File associations” panel (see 6 for details) is opened by the main menu entry “Tools>File 

associations”. Files from the SimDM server are opened according to their extensions. This panel manages 

associations between file extensions (.doc, .pdf, .txt and so on) and external applications that will be used 

to open files that are stored in or referenced from SimDM. 

5.4 Product Structure browser 
This panel represents Product Structure (PS) data, such as Folder, Approval, Person and attached File. 

The panel offers the following three views; these are from left to right the following: 

• Tree. FOLDER objects are shown in a tree structure, that is, with their parent-child relationships. 

The tree-view behaves like a folder structure in a file system. 

• Details. The Details-view displays the content of a selected folder, such as, child folder objects, 

approvals, files and so on. Folder meta data may be viewed by information category; there is one tab 

for each category (“Approvals”, “Organizations”, “Persons” and so on). Or, all types of objects can 

be seen together in the “All items” tab. 

• Properties. Each item in the Details-view may have several properties. All properties of a selected 

item are presented in the grid of the Properties-view. 
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Figure 6. The three panels of the product structure browser 

Only the Tree-view is shown by default. The other views can be shown/hidden by using tool bar buttons 

inside the “Product Structure browser” panel. 

Several Product Structure browser panels can be open simultaneously, but maximum two can be viewed 

concurrently.  

5.5 CAX viewer 
VCollab Presenter is started in this panel as an ActiveX component. Functionality for loading and 

manipulating the view of a 3D model is available from the main menu and from a context menu. Please, 

refer to the context menu “Help…” entry for guidance on how to apply this functionality. 

Besides opening this panel manually form the “CAX viewer” menu item, it will start automatically when 

you open a file that was converted to the CAX format at upload time (AP242 and its predecessors, AP209 

and NASTRAN files). Starting VCollab may take some time – please, be patient. 

6 File associations 
The “EDMopenSimDM file association management” panel can be shown by choosing the “Tools” → 

“File associations” main menu item after having logged in. 

The panel presents dependencies between file extensions (.txt, .pdf, .doc), descriptive file type names 

and paths to one or several viewer applications that are adequate to open this sort of file. 

Descriptive file type names are in the “File type” column. Usually it is a short human readable text; for 

example: “ABAQUS FILE”, “CATIA V5”, “NASTRAN Output File”. 
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Column “External viewer” can contain a path to an external executable that is used by default to open 

files of that specific type from the SimDM browser. If a path is not set, the text “By system default” is 

shown. This means that such files are opened from the SimDM browser by the application that is 

registered for this specific file extension in the client machine, that is, normally VCollab Presenter. 

Note: If you should change the default setting and then want to redo your change, simply empty the path 

in the “External viewer” field. This will again make VCollab the selected application. 

Column “Preferred” indicates whether the entry in column “External viewer” is the preferred tool to open 

the correspondent type of file. 

Note: Uploaded .stp-files of types AP203, AP209, AP214, AP242 and NASTRAN-files with extensions 

.bdf and .op2 are converted to CAX. Unless “Preferred” indicates anything else, the SimDM internal 

CAX viewer tool, VCollab Presenter, will be used to open the uploaded file (“Open” context menu item). 

Column “Command options” represents command line arguments for specified external viewer. 

Command line option <FILE> represents the file that will be opened by the external viewer. Additional 

command line parameters that are accepted by the specified external viewer may be added. 

Figure 7 shows the panel where the table is grouped by the “Description” column. Any column header 

can be dragged and dropped into a place above the table to group the table by that column. 

 

Figure 7. “EDMopenSimDM file association management” panel 

 

The table is editable. New items can be added (“Add” button), edited (“Edit” button) and removed 

(“Remove” button). 
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Figure 8. Add a file association via file extension 

A single file extension may be associated with one or several tools. To give the user a selection of 

applications to open a file with, use the “File association:” “Add”-command (see Figure 8). Fill into the 

pop-up window the same extension name that there is a file association entry for already. Enter a 

description into the field “File type:” and into “External viewer:” the path to the executable on your 

machine or network 

In case of several tools, the following applies: 

• The file extension editor has a checkbox where you can specify that this tool is the preferred or 

default tool (see Figure 8). The preferred tool is the tool that shall be started when you double-click 

on a file with the corresponding extension, even with more than one tool being assigned to the file 

type.  

• The “Open with” command (context menu for a file) displays a form where you can select which 

tool shall be started. 

7 User management 
Each user of EDMopenSimDM has a login identifier, which gives access to the EDMopenSimDM client 

and server. Such login identifiers are defined in the “User Management” panel (see Figure 9). 

EDMopenSimDM is delivered with several users defined. Each user has password “db”. 
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Figure 9. User management panel 

7.1 Add user to EDMopenSimDM 
The User management panel enables you to add more users. Selecting “Add” launches the pop-up 

window as seen in Figure 10. 

 

 

Figure 10. Create a new user 

 

EDMopenSimDM users are assigned types of access to the system. Users may play two types of roles: 

• UserManager2 – can create/update/delete users. 

• SystemManager – can create new product structures (see 8.4), create new login identifiers, do Final 

Approval (see 9.7.3) and has the rights of a SystemUser. 

• SystemUser – can play roles in product structures as Admin, Editor or Reader (see 9.4.5). 

A SystemManager typically creates a product structure top item and the main product structure tree 

below; SystemUser will extend this with branches as needed. 

 
2  Only “superuser” is defined with UserManager role.  
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Note: Persons with login identifiers that are not explicitly assigned to a product structure will only see 

model names in the repositories and models panel, but will not be able to open models in the product 

structure browser. 

New users will be given the following default password: “<login identifier>-123”. 

This password starts with a capital letter followed by lowercase letters, one or more hyphen symbols, and 

"123". The password shall be at least 7 symbols. Thus, the number of hyphen symbols depends on the 

number of symbols in the login identifier. 

Example: "User-123" 

Users may also provide their e-mail addresses. Notifications will be sent to these addresses for 

subscriptions that users have signed up to (see chapter 12). 

8  “Repositories and models” panel 
If login is successful, the “Repositories and models” panel is opened in a panel container. This panel is 

closed and opened by the following main menu item: 

“View” → “Repositories and models” 

8.1 Appearance 

 

Figure 11. “Repositories and models” panel 

Appearance of the panel can be seen on Figure 11. It consists of three parts: repositories, models and 

information part. 

The left side of the panel contains the list of repositories that are available to store models with Product 

Structures (PS). New repositories can be created using the context menu (right-click for right-handed 

mouse) for this part of the panel. 

Each repository can have zero, one or many models. The right side of the panel contains the list of models 

for the selected repository. New product structure models can be created either from scratch or can be 

imported from an archive package (see 9.11). 

The lower part of the panel includes a status view, that is, name, description, created date and so on for 

the selected model. 
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8.2 Server panel context menus 
The left side with the repositories has only one menu item in its context menu – “Create repository…” 

The right side has two context menus, one for a selected model (see Figure 12) and another one if no 

model is selected (see Figure 13). 

 

Figure 12. Context menu for models 

 

Figure 13. Context menu if no model is selected 

The following menu items are available. 

• “Open” – opens product structure (PS) in a separate “PS browser” panel (see chapter 9). Mouse double 

click can be used instead of this menu item. 

•  “Info” – opens table with information about the product structure. 

• “Create model…” – opens dialog to create a new model. 

• “Delete model…” – opens dialog to confirm the permanent removal from the database of the model 

and of all the AP209 models derived from it. 

•  “Import from archive…” – retrieves an archived product structure or baseline (see 9.11 Import from 

archive) into a new model. 

8.3 Create repository 
When “Create repository…” context menu item is selected, the following dialog appears (see Figure 14). 

Both text fields are empty by default. 
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Figure 14. Dialog to create repository 

ISO 10303 STEP and, thus, EDMopenSimDM require special syntax for repository names. It needs to 

start with an ASCII letter, followed by ASCII letters, digits and underscores. Blanks and punctuation 

symbols are not allowed. It is not possible to enter invalid symbols. 

Description can be multiline text with any characters. 

8.4 Create model 
When the “Create model…” context menu item is selected, the following dialog appears (see Figure 15). 

The first item to be selected is in the “Type” combo box. 

The “Name” text field proposes a default name for the PS. 

 

Figure 15. Dialog to create a model / product structure 

The “Model” text field contains the name that will be given to the EDMopenSimDM model for this PS. 

The same constraints for valid characters apply as for EDMopenSimDM repository: it should start with 

an ASCII letter, followed by ASCII letters, digits and underscores. Blanks and punctuation symbols are 

not allowed. It is not possible to enter invalid symbols. 

“Description” and “Comment” are optional text fields. 
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The current user is automatically assigned to the Product Structure. The “Login” attribute of that person 

object contains the login credentials of the current EDMopenSimDM user. This person becomes the 

manager of this PS. 

A top folder object will be created for the PS that contains the following additional attributes: 

• Creator – the person who created the PS. 

• Introduced – the date and time when the PS was created. The local time is used. 

• Model – the name of the EDMopenSimDM model where the PS is stored persistently. 

• Persons – the person who created the PS; although being an aggregate, only one element is stored. 

9 “PS browser” panel 
The “PS browser” panel is opened either by selecting the “Open” context menu item for models in the 

“Repositories and models” panel or by double-clicking on a model name. The “PS browser” panel opens 

opposite to the “Repositories and models” panel. The caption at the top of the panel has the following 

format: 

_Repository_/_Model_ - Person: _user_login_ (_user_role_) 

Where _Repository_ is EDMopenSimDM repository name, _Model_ is EDMopenSimDM model name, 

_user_login_ is login of logged in user and _user_role_ is user role for the current PS (Admin, Editor or 

Reader). 

The “PS browser” panel contains three views: Tree, Details and Properties. By default only the Tree-

view is shown. The views can be shown or hidden by using the tool bar in the panel (see Figure 16). 

 

Figure 16. Tool bar in “PB browser” panel 

9.1 “Tree” view 
The left view (Tree) includes the product structure as tree. Top/root folder and children items have 

different context menus (see Figure 17 and Figure 18). 

Note, the content of menus is dependent on user access rights for the top folder and each subordinate 

folder (see 9.4.6 for how folder access rights are determined). A user with “admin” access rights will be 

able to see all menu items represented in Figure 17 and Figure 18. A user with “editor” access rights will 

be able to see less menu items. A user with “reader” access rights will be able to see only “Add 

comment…”, “Copy”, “Info…” and “Export to archive…” menu items. A user without any access rights 

to a folder, will not be able to see any context menu items for this folder. 

The top folder represents the product structure itself. Besides children items, it may be assigned the 

following types of resources: 

Three buttons to 

show/hide panel views 

Opens copy of “PS 

browser” panel 
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• persons, 

• organizations, 

• approvals, 

• properties, 

• methods. 

These resources are definitions only. They may be assigned to individual children items as the product 

structure evolves. First then a person, for example, gets a role and a property a value. The following rules 

apply: 

• All resources are available to all children items in a product structure, also to new versions of these. 

• Resources may be removed. If they at that point in time, were already used and assigned, these 

assignments will not be removed. However, the resource will not be available any more for new 

assignments. 

• Resources cannot be assigned to children items that are in read-only mode (which may be either 

because the user only has read-only access or because the item has been finally approved and is, 

therefore, frozen). 

• The resources themselves, however, can be edited – by users with proper access rights - even though 

their assignments may not. All children of a product structure may be frozen; anyhow, it will be 

possible to change the name of a person who is assigned to one or several of these children. 

 

Figure 17. Product structure context menu for administrators 
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The context menu for a product structure top/root folder consists of the following menu items: 

• “Add approval…” – opens dialog to create “approval” definition object for later use in assigning 

approvals to folders (see 9.7.1). The created approval will appear in the middle (Details) view. Only 

administrators can perform this function. 

• “Add child…” – opens dialog to create a first level folder (see 9.12). 

• “Comment…” – opens dialog to create “comment” object (see 9.8). Created comments appear in the 

middle (Details) view. 

• “Add task method…” – opens dialog to create “method” object (see 9.6). Methods may later be used 

in task descriptions (see 9.6.2). The created method will appear in the middle (Details) view. Only 

administrators can perform this function. 

• “Add organization…” – opens dialog to create “organization” object (see 9.5.1). The created 

organization will appear in the middle (Details) view. Only administrators can perform this function. 

• “Add person…” – opens dialog to create “person” object (see 9.4.1). The created person will appear 

in the middle (Details) view. Only administrators can perform this function. 

• “Add property…” – opens dialog to create “property” object (see 9.9.1). The created property will 

appear in the middle (Details) view. Only administrators can perform this function. 

• “Baseline” -> “New baseline…” – opens dialog to create a baseline and define its contents (see 

9.23.1.1). Only administrators can perform this function. 

• “Baseline” -> “Show” -> ... – lists all available baselines and opens the contents of the one selected 

in a separate panel (see 9.23.1.2). 

• “Baseline” -> “Remove” -> ... – lists all available baselines and removes the selected one after 

confirmation (see 9.23.1.3). Only administrators can perform this function. 

• “In-work package” – contains menu items similar to “Baseline” (see 9.23.2). 

• “LOTAR package” – contains menu items similar to “Baseline” (see 9.23.3). 

•  “Find…” – opens panel search form to specify criteria for finding text strings in the database (see 

9.24). 

• “Rename…” – opens dialog to change the name of top folder. 

• “Expand all” – expands all branches below the selected top folder. 

• “Final approval…” – assigns a final approval to the product structure and its entire contents (see 9.7.3). 

A final approval is required to include a folder in a baseline. Only administrators can perform this 

function. 

• “Export to archive…” – stores a zip-file that includes the AP209 STEP file of the EDMopenSimDM 

management data and the files that are attached to the entire product structure in a user-defined 

location (see 9.10). 

• “Import from model…” – copies the contents of a different model and possibly different repository as 

branch to the current folder. 

• “Import local folder” - imports folder and its content (subfolders and files) to selected branch of 

product structure (see chapter 9.25). 

• “Paste” – adds a copied or cut tree branch (only “folder” objects, not files) to the selected folder. 

Requires that a folder was copied or cut.  

• “Lock” – locks the entire tree for access by others than the person entitled by this command; the access 

rights of this person (admin, editor, reader) will remain unchanged. The menu item will change to 

"Unlock". The lock will automatically be removed when the assigned person is deleted. 
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• “Unlock” – this menu item is the toggle to “Lock”. The original access rights will be re-established. 

 “Info…” – opens table with information about the product structure. 

 

Figure 18. Folder context menu for administrators 

 

The context menu for child elements consists of the following menu items: 

• “Add child…” – opens dialog to create a sub-folder (see 9.12.1). 

• “Comment…” – opens dialog to create “comment” object (see 9.8). Created comments appear in the 

middle (Details) view. 

• “Check STEP files…” – (see 9.14.6) 

• “New File” → “Upload…” – opens dialog to upload one file (see 9.14.1). 



EDMopenSimDM™ Application Reference Manual, R17 

 

2022-06-01  Page 32 

 

• “New File” → “External link…” – opens dialog to assign the path of a file to the selected folder (see 

9.14.2). 

• “New File” → “Import Product structure…” – Retrieves Product structure from selected STEP file 

(see chapter 9.15). 

•  “Add task…” – opens dialog to assign a task to the selected folder (see 9.6.2). The created task will 

appear in the middle (Details) view. 

• "Versions" → "Add folder version…” – opens dialog to create a version for the selected folder (see 

9.13.1). 

• "Assign" → “Assign approval…” – opens dialog to assign one of the approvals that are defined for 

this product structure to the selected folder (see 9.7.2). The created approval will appear in the middle 

(Details) view. Only administrators can perform this function. 

• "Assign" → “Assign organization…” – opens dialog to assign an organization to the selected folder 

(see 9.5.5). The created organization will appear in the middle (Details) view. Only administrators can 

perform this function. 

• "Assign" → “Assign person…” – opens dialog to assign a person to the selected folder (see 9.4.5). 

The created person will appear in the middle (Details) view. Also the default access rights for the 

person may be changed here. Only administrators can perform this function. 

• "Assign" → “Assign property…” – opens dialog to assign a property to the selected folder (see 9.9.3). 

The created property will appear in the middle (Details) view. 

• “Rename…” – opens dialog to change name of selected child element. 

• “Update…” – opens dialog to update properties (name, description and type) of a selected folder. 

• "Remove folder" – removes selected folder (version) and subordinate branches permanently from all 

parent folder versions (see 9.12.3). 

• "Exclude from parent" – removes selected folder (version) from its parent, but only from the current 

version of parent folder (see 9.12.2). 

• "Subscribe to notification..." - person or organization may be subscribed to e-mail notification (see 

chapter 12) 

• “Expand all” – Expands all next level folders below the selected folder. 

• “Lock” – locks the current branch for access by others than the person entitled by this command; the 

access rights of this person (admin, editor, reader) will remain unchanged. The menu item will change 

to "Unlock". The lock will automatically be removed when the assigned person is deleted. 

• “Unlock” – this menu item is the toggle to “Lock”. The original access rights will be re-established. 

• “Final approval…” – assigns a final approval to a folder and its subordinate branches (see 9.7.3). A 

final approval is required to include a folder in a baseline. Only administrators can perform this 

function. 

• “Export to archive…” – stores a zip-file that includes the AP209 STEP file of the SimDM management 

data and the files that are attached to the selected folder and its subordinate branches in a user-defined 

location (see 9.10). 

• “Import native data…” – Opens a sub-menu with entries to wizards for the import of different types 

of files (see chapter 9.15). 

• “Import from model…” – copies the contents of a different model and possibly different repository as 

branch to the current folder. 

• “Import local folder” - imports folder and its content (subfolders and files) to selected branch of 

product structure (see chapter 9.25). 
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• “Copy” – remembers selected folder and its subordinate branches (see 9.12.4). The collection can be 

pasted to another parent in the same product structure. 

• “Cut” – remembers selected folder and its subordinate branches and removes them after paste (see 

9.12.5). The collection can be added to another parent by “Paste”. 

• “Paste” – creates previously copied or cut folder and its possibly attached branches below selected 

folder; also meta data are pasted. 

• “Paste link” – Creates link of copied folder (or file) 

• “Info…” – opens table with information about the selected folder. 

 

If folder has only one single version, tree node represents only folder name. If folder has more than one 

version, tree node represents folder name and current folder version in square brackets. 

9.2  “Details” view 
The middle view (Details) represents top folder content (children folders, approvals, persons, 

organizations…) or the content of a selected folder (children folders, assignments, attached files, 

references, comments…). The view can be shown/hidden by toggling the “Details” button on the tool 

bar (see Figure 16). 

There are a number of selections to represent either all kinds of objects (“All items”) or objects by their 

kind (“Children”, “Approvals”, “Persons” and so on). 

“All items” tab represents all kind of objects as a list with an icon for each item (see Figure 19). 

 

Figure 19. “Details” view 

The first item of the list is the special item “..”. The “Details” view will display the content of the next 

higher level (one level up) of the PS tree by double-click on the “..” item. The same happens if the “Enter” 

key is pressed when this item was selected. 

The “Details” view displays the content of the next lower level (one level down) of the PS tree by double-

click on the folder item. The same happens if the “Enter” key is pressed when the folder was selected. 

Each object on the list has its own context menu. 

The remaining selections (“Children”, “Approvals”, “Persons” and so on) display one kind of object per 

selection. 

Each item type in “All items” selection has its own context menu items. The content of the context menu 

depends on the user’s access rights to the selected top folder. For example, user with “reader” access 
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rights is not able to use menu items concerning functionality for editing. User, who does not have any 

access rights to a folder, is not be able to see any content of a folder, selected in a “Tree” view. 

 

If folder has only one single version, only folder name is represented in "All items". If folder has more 

than one version, folder name and current folder version in square brackets are represented in "All items". 

9.3 “Properties” view 
The right part of the panel (“Properties”) displays scalar and aggregated properties (attributes) of a 

selected object (see Figure 20). 

 

 

Figure 20. “Properties” part of the “PS browser” panel 

The values of a selected object cannot be changed in the “Properties” grid, only browsed.  

9.4 Person 

9.4.1 Add 

A new person object can be added to the Product Structure as a user. The person is assigned default 

access rights, which may be changed (“Assign person” functionality) for each PS folder. The following 

dialog appears (see Figure 21) after the “Add person…” context menu was selected. 
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Figure 21. Dialog to create a person 

By default all input fields are empty. The greyed texts are proposals for input and select values. The 

combo box “Type” contains the following possible types for person access rights (see 7): 

• Admin 

• Editor 

• Reader 

• Undefined 

The administrator (admin) defines the entire infrastructure for his/her product structure in terms of 

resources, methods, properties, organizations and types of approval status. Administrators can include 

other persons with login access to EDMopenSimDM to his/her product structure and restrict the access 

rights for these persons to the product structure and to individual folders in it. Only administrators can 

apply final approvals as needed for baselining. And only they can create baselines. Administrators may 

assign a person as administrator or editor of a branch and will typically include a task description with 

this assignment. 

Editors fill folders with contents in terms of subordinate folders and files. Different editors may assign 

their approvals to folders. The folder responsible will respond with feedback to a task description. 

Readers can browse through the product structure contents. 

The combo box “Login” contains available SimDM logins, but it is possible to write login names of not 

yet created SimDM users instead. 

A person has a human name in addition to a login name. 

A person may have e-mail assigned. Specified e-mail will be used to send notifications (see chapter 12). 

Note: It is currently possible to assign different names and e-mails to the same login-name in different 

product structures. This feature will probably change in future EDMopenSimDM releases so that a single 

login-name is always assigned the same person name.  

Text fields “Description” and “Comment” are optional and can be omitted. 
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9.4.2 Update 

A person object can be edited by selecting “Update…” context menu item for selected person object in 

“Details” view. The same dialog (see Figure 21) appears. Text in all fields can be changed. Person object 

is updated by clicking “OK” button. 

9.4.3 Rename 

Name of the existing person can be edited by selecting “Rename…” context menu item for selected 

person object in “Details” view. Person object is renamed by clicking “OK” button. 

9.4.4 Remove 

A person is removed by the “Remove” entry in the context menu when you right-click (right-hand mouse) 

on a person’s name in the “All Items”-tab of the detail view. 

The same entry is used to remove a person both from its assignment to a folder and from the entire model. 

 

Figure 22. Examples of a removed, but still assigned person and an organization 

To remove a person from the model select the top folder of the model and select “Remove”. If the person 

is assigned to a folder within the selected model, he/she will not be removed, but cannot be assigned any 

more. This is indicated by the name of the person being struck through in the detail view of the top folder. 

The assignment occurrences to lower level folders will not change appearances. Such partial removal can 

be undone by using the “Update …” entry in the person context menu on the top folder. 

9.4.5 Assign 

Person assignment can be used to change default access rights for a specified person (user with login 

credentials) in the selected folder (branch of Product Structure). The following dialog appears (see Figure 

23) after selecting “Assign person…” context menu for the current folder. 



EDMopenSimDM™ Application Reference Manual, R17 

 

2022-06-01  Page 37 

 

 

Figure 23. Dialog to assign person to folder 

Combo box “Person” contains all persons that are defined for this PS. Combo box “Type” contains the 

following types of access rights: 

• Admin – user has administrator (manager) access rights. User can create new persons, assign access 

rights for them, approve actions and so on. 

• Editor – user is an editor. User can create new folders, upload files and make some updates. 

• Reader – user can not update the product structure, but can add comments to objects. 

• [No access] – user looses all access rights for the specified folder and its underlying branch(es). 

 

An assignment object may be given a name. This should be different from the name of the assigned 

person. Text fields “Description” and “Comment” are optional and may be omitted. 

Note: For repeated assignments of the same person to the same folder the latest assignment will overwrite 

the previous one. 

9.4.6 Determination of access rights 

The following basic rules apply for granting product structure access rights to persons with a SimDM 

login account: 

1. Persons who shall have any type of access to a product structure need to be defined in the top 

folder of this structure (see menu item “Add person...”, 9.4.1). In this operation persons may be 

assigned one of the following roles: admin, editor or reader. A person will have this role per default 

for all children folders of this product structure unless other roles are assigned locally. 

2. A person may be assigned to any sub-folder and, thus, be given a different role than the default 

role (see menu item “Assign person...”, 9.4.5). Folders that a person has access to may lie below 

folders that this person does not have access to. The person will see the contents of the lower level 

folder, but not the details of the parent folder. 
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3. A person may be member of organizations. An organization may be assigned to sub-folders, and 

in that operation the organization and its members are assigned one of the following access rights: 

administrator (manager), editor, reader, [Use default type] or [No access]. 

4. The combination of assignments of person and organization to a folder specifies the access rights 

of a person and will result in one of the following four roles: administrator (manager), editor, 

reader or [No access]. 

The calculation of the access rights for a person in a folder is based on the following priorities:  

1. Main priority is the role given by the assignment of the person to the folder. E.g. a person with 

any default role who may be member of any group could be assigned to a folder with role equal 

ADMIN (manager), EDITOR (writer), READER or NO ACCESS (ineligible). After that the 

person will have this access level to the folder and its children (unless the person is assigned to 

one or several sub-folders with different access rights).  

2. Second priority is the role given by the group (organization) assignment. It is taken into account 

for persons without explicit person assignment to the sub-folder. Over the folder domain 

(including child folders) all members of the assigned group (organization) will be granted the same 

role (that could be reassigned on child level). 

3. Third priority is the role inherited by the person from the parent (using) folders of the current 

folder. Normally a person inherits access rights (role) from the parent folder (if there are no direct 

person or organization assignments in the folder). If the folder is child of several parents (the 

EDMopenSimDM server provides this feature) the least powerful role is inherited (NO ACCESS 

has higher priority than READER, READER has higher priority than EDITOR, etc.). 

4. Fourth priority is the default role of the person's group/organization. If the person is assigned to 

several organizations, he/she will be given the richest of the access rights given to these 

organizations. 

5. Fifth priority (if there are no direct person or organization assignments from the current folder and 

up to the top folder) is the default top folder role of the person (initially defined or later updated). 

9.5 Organization 

9.5.1 Add 

Organizations in SimDM can be used just to group person objects together by a criterion. Persons can, 

for example, be grouped to give all members the same access rights. The following dialog appears (see 

Figure 24) after the “Add organization…” context menu was selected. 
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Figure 24. Dialog to add organization 

Combo box “Type” contains the following possible types for organization access rights. 

• Group – all members have their own default access rights. 

• Department – all members have their own default access rights. 

• Admin – all members have administrator (manager) access rights. Users can create new persons, 

assign access rights to them, approve actions and so on. 

• Editor – all members are editors. Users can create new folders, upload files and make some updates. 

• Reader – members can not update the PS, but can add comments to objects. 

“Members” control is used to select members for the organization. 

Organization may have its e-mail. Specifies e-mail will be used to sent notifications (see chapter 12). 

9.5.2 Update 

Existing organization object can be edited later by selecting “Update…” context menu item for selected 

object in “Details” view. The same dialog (see Figure 24) appears. Text in all fields can be changed. 

Organization object is updated by clicking the “OK” button. 

9.5.3 Rename 

Name of the existing organization can be edited later by selecting “Rename…” context menu item for 

selected object in “Details” view. Organization object is renamed by clicking the “OK” button. 

9.5.4 Remove 

An organization is removed by the “Remove” entry in the context menu when you right-click (right-

hand mouse) on an organization’s name in the “All Items”-tab of the detail view. 

To remove an organization from the entire product structure – not only from its current assignment - 

select the top folder of the model and select “Remove”. If the organization has already been assigned to 

a folder within the selected model, it will not be removed, but can not be assigned any more. This is 

indicated by the name of the organization being struck through in the detail view of the top folder. The 

assignment occurrences to lower level folders will not change appearances. Such partial removal can be 

undone by using the “Update …” entry in the organization context menu on the top folder. 



EDMopenSimDM™ Application Reference Manual, R17 

 

2022-06-01  Page 40 

 

9.5.5 Assign 

Organization assignment can be used to change the default access rights of a specified group of persons 

(organization) for the selected folder (branch of Product Structure). The following dialog appears (see 

Figure ) for the “Assign organization…” context menu for the current folder.  

 

Figure . Dialog to assign organization to folder 

Combo box “Organization” contains all available organizations for the PS. Combo box “Type” contains 

following access rights (types): 

• Admin – all members have administrator (manager) access rights. User can create new persons, assign 

access rights for them, approve actions and so on. 

• Editor – all members are editors. User can create new folders, upload files and make some updates. 

• Reader – all members cannot update the PS, but can add comments to objects. 

• [No access] – all members loose all access rights for the specified folder (branch). 

• [Use default type] – all members have theirs default access rights (admin, editor or reader). 

An assignment object may be given a name. This should reflect the role of the organization in this context 

and should, thus, be different from the name of the assigned organization. Text fields “Description” and 

“Comment” are also optional and may be omitted. 

Note: For repeated assignments of the same organization to the same folder the latest assignment will 

overwrite the previous one. 

9.6 Methods 
Method objects define how tasks shall be done. 

9.6.1 Add task method 

Methods are defined for a product structure first, before they can be assigned to individual folders as part 

of task descriptions (see 9.6.2 New task). Many properties may be defined for a product structure; a folder 

may be assigned many tasks descriptions. 
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To define a method, use menu item “Add task method…” of the context menu of the product structure 

folder. The following dialog will pop up: 

 

Figure 25. Dialog to add method 

“Description” should contain a clear guidance for how to perform a task. 

Text field “Comment” is optional and can be omitted. 

The following context menu items exist for task methods: 

New comment…: see 9.8 Comment 

Remove: If the method is not yet used in a task assignment, it is deleted. If it is in use already, further 

use will be disabled, that is, the method can not be used in task assignments any more. 

9.6.2 New task 

A task object specifies a job that shall be done by a person using one or several methods for a selected 

folder. The following dialog appears (see Figure 26) after triggering the “Add task…” context menu item 

for a folder. 

The combo box “Person” contains all available persons for the PS. The combo box “Method” contains 

all available methods for the PS. 

 

Figure 26. Dialog to create a task 
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“Name” is mandatory and shall contain a human interpretable text under which the task shall be known. 

“Description” is optional and may contain details of the task specifications potentially with reference to 

input data, tools and resources. 

The controls “To start” and “To finish” should contain date and time when the task is supposed to be 

started and finished. 

9.7 Approval 
Approvals may be assigned to folders for communication among co-workers. Before being assigned, 

however, they need to be defined. Each product structure may have its specific set of approvals. Besides 

this generic approval functionality EDMopenSimDM offers the concept of a final approval which is 

required for baselining folders. 

9.7.1 New 

New approval definitions can be defined for a Product Structure with the “Add approval…” context menu 

item. The following dialog appears (see Figure 27). 

 

Figure 27. Dialog to define a type of approval 

Combo box “Type” contains the following possible types of approval outcomes: 

• negative, 

• neutral, 

• positive. 

This categorization may be used for automatic processing of approvals; it will not appear in the details 

view of a folder, only in its property view. 

Text field “Name” is the text that this type of approval will be known as. It is mandatory and will appear 

in the details view. 

Text fields “Description” and “Comment” are optional and can be omitted. 

Note: If an existing type of approval is defined once again, the previous definition is updated; no new 

approval is created. 
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9.7.2 Assign 

One or more approval definitions can be assigned to folders. The following dialog appears (see Figure 

28) after selection of “Assign approval…” context menu item for the selected folder. 

 

Figure 28. Dialog to assign approval 

One of approval definitions (that were earlier created for PS) shall be selected in the “Approval” combo 

box. An assignment object may be given a name. This should indicate the role of the approval in this 

context and should, thus, be different from the name of the assigned type of approval. Text fields 

“Description” (for example, details of the role of the approval) and “Comment” are optional and may be 

omitted. 

Note: A folder may be assigned as many approvals as there are users with write access to this folder. A 

user may only assign one approval. A second approval assignment by a person replaces the previous 

assignment of this same person. 

9.7.3 Final approval 

To finally accept the contents of a folder, use the “Final approval…” menu item of the product structure 

or of the folder context menus. 

 

Figure 29. Dialog for giving final approval 

This will not only approve the selected folder, but also all underlying branches. The names of finally 

approved product structure folders turn to italics font. Only folders with such approval can be included 

in baselines. Only administrators of a product structure can give final approval. 

The function works like a toggle: apply the function a second time on a folder, and the approval will 

disappear. 
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Note: To speed up the change of folder name font to, for example, italics, close and open the relevant 

part of the product structure tree. 

Note: Final approval cannot be redone for archives that have been exported. 

9.8 Comment 
All objects (except references to folder objects) can be commented. 

9.8.1 New 

Usually, the dialog to create an object has text field for filling in a first comment. Further comments may 

be added later. The following dialog appears (see Figure 30) for the “Add comment…” context menu 

item. 

 

Figure 30. Dialog to add comment 

A comment has a header (“Name” text field) and a text itself (“Description” text field). Both text fields 

are mandatory. 

9.8.2 New feedback 

A comment can be commented; the second comment is then called a feedback. A series of related 

comments can be viewed as such in the property view. 

9.8.3 Remove 

To remove a comment select the “Remove” item from the comment context menu. A window will pop-

up to receive your confirmation. 

9.9 Property 
Users can assign property values to folders of product breakdown structures. The property itself, that is, 

the type of property, shall be defined on the root level of the breakdown; the property values are given 

within the applicable folder types. The property definition specifies property name, value type, units (for 

numerical), mandatory/optional flag, default value, and the set of applicable folder types (folder types 

where the property will appear and can be given a value). 

9.9.1 New property definition 

To introduce a new type of property, select the root folder of the current product tree, open the root folder 

context menu (right mouse click) and fill the following into the dialog that is shown in Figure 31: 

 Name mandatory human interpretable text string to identify the property (shall be 

unique) 
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 Units optional unit of measure for values of the property 

 Description optional property description 

 Type optional property value type; you may select one of the following entries: 

• boolean_property 

• double_property 

• integer_property 

• string_property 

 Applicable to mandatory list of folder types that will show this type of property; select at least 

one folder type name from the drop-down list 

 Optional/Mandatory mandatory flag: 

• for “Mandatory”, a property value shall be specified for all instances in 

all applicable folder types (at least the default value; see below). 

• for “Optional”, a property value may be assigned to property instances 

in applicable folder types. 

 Default Value shall be specified for mandatory properties. This value will automatically 

appear as value of the current property after creation of a new folder. Users 

with appropriate access rights may change the value. 

 Vector/Scalar specify whether the property has a single value (scalar) or a value list (vector; 

e.g. 3D coordinates: x, y, z). For value list, specify lower and upper bound of 

the list. 
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Figure 31. Dialog for the definition of properties 

9.9.2 User defined properties representation 

The list of user defined properties is represented in the details view (middle section) of the root folder. It 

is available in two forms: 

• “All items” mode: defined properties are listed together with other definitions (users, 

organizations, classes…); 

• Dedicated table of properties: this table appears when “property” is selected from the drop down 

list of the section header. 

In “All items” mode, properties are represented only with their names; in “property” mode, the user can 

see a detailed table of property attributes. Even more details appear in the property view (right section) 

per property definition when a property element is selected in the details view (middle section). 

9.9.3 Assign a property value to a folder 

Select a target folder (in the tree view or the details view), open the context menu (by right mouse click), 

select “Assign” item and then from the sub menu “Assign property…”. A dialog appears with the caption 

“Assign property to node…”; select a property definition from the “Property” drop-down list and write 

a property value into the “Values” text box. For aggregative properties (Vector), write a comma separated 

list of values (use a list separator according to your local MS Windows-settings).  

Apply the same procedure to modify a property value.  
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Figure 32. Assigning a property value to a folder 

9.9.4 Remove property value 

Select a target property (in the details view of a folder), open the context menu (by right mouse click) 

and select “Remove”. A property, that has been defined as optional, will be deleted from the folder 

immediately. To remove a property, that has been defined as mandatory, at first, remove its property 

definition from the root folder; otherwise, there will be no option “Remove” in the context menu. 

9.9.5 Remove property definition 

Select the target property (in the details view of the root folder), open the context menu (by right mouse 

click) and select “Remove”. If the property is not assigned to any folder, it will be deleted from the root; 

otherwise, it will just be deprecated. Deprecated properties cannot be assigned values anymore. Existing 

property value assignments (this is valid for both optional and mandatory ones) will appear as before. 

They can be removed, but they cannot be changed. 

9.10 Export to archive 
This function creates an archive package of an entire Product Structure, of one of its branches or of a 

baseline. For export of baselines and in-work packages, these need to be specified first by the 

corresponding top folder context menu items “New baseline...”, “New LOTAR AIP…” and “New In-

work package ...” 

When triggering the function from the context menu of a child folder you will immediately be prompted 

with a file browser window with the dialog “Save archive as…” to select the location for the archive zip-

file. Depending on the type of package, the system suggests the following package names: 

<model name>__archive__<node name> 

<model name>__in-work__<node name> 

<model name>__baseline__<baseline name> 

Provide your choice of folder and file name. If the identified file exists already, it will be overwritten. 

When triggering the function from the context menu of the Product Structure folder, the following 

window pops up: 
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Figure 33. Export to archive options 

You may export the entire product structure, one of its in-work packages, one of its baselines or one of 

its LOTAR archives. For product structures you may or may not include its history, that is, all versions 

of all product structure folders. If this tick-box is not selected, only the current version is exported. The 

Baseline, In-work package and LOTAR fields are only selectable if you defined at least one baseline, in-

work package or LOTAR archive. Baselines, in-work packages and LOTAR archives include only 

current folder versions; the history tick-box is, therefore, not relevant. 

A background process creates the export package zip-file. You may, therefore, continue with other tasks 

during the creation and download processes. When they are completed, you will be notified by an alert 

window (see Figure 34). 

 

Figure 34. Alert window after ZIP package is downloaded 

The zip-file for archival has the following characteristics: 

• the folder structure within the zip-file corresponds to the product structure, that is, each product 

structure folder represents an operating system folder; 

• the top folder is always the product structure folder even if the archived folder is several levels 

within the product structure; 

• the names of the files that are attached to the folders are maintained. However, to maintain 

uniqueness of folders on the operating system level, those folder names consist of the following 

three components: folder name, folder type and folder version. For example for a folder with only 

one version: ”STEP Input DOCUMENT”; 

• the meta data of the product structure and its folders are exported into an ISO 10303-21 file that 

corresponds to the EXPRESS model of the EDMopenSimDM master model; this is included in 

the top folder of the zip-file; 

• the EDMopenSimDM master model is converted to AP209, and the resulting P21 file is also 

included in the top folder of the zip-file. 
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• the text file “pdi.txt” that contains PDI. 

Thus, when unzipping an archived file in your operating system, the product structure will be recreated 

as folder structure with the attached files within them. 

An archived file can be imported back into EDMopenSimDM to create a new model within an arbitrary 

repository; see chapter 9.11 Import from archive. 

Note: The following limitations apply currently: 

1) File names shall be unique within a product structure. 

2) Very large files, that is, 1GB and more, may cause the system to stop. 

3) The mapping from the EDMopenSimDM master model to AP209 needs to be revised and 

completed. 

9.11 Import from archive and Import from model 
The function “Import from archive...” can only be executed from the context menu of the repositories 

and models panel. You will be prompted with a Windows file browser to find the location of the zip-file. 

After having selected an appropriate SimDM zip-file you will be asked for the name of the model. 

Provide a name that is unique within the repository and that has a valid syntax (see 8.4). The archive will 

be added as a new model to the current repository. 

The function “Import from model...” is available from context menus in the product structure panel. It 

enables you to reuse a previously defined and exported structure as a copy within the current structure. 

 

Figure 35. Pop-up window for “Import from model...” 

You cannot import directly into a structure; you need to go via a new model. This is to enable quality 

control and adaptation of the imported structure before taking it in use in an operational structure.  

The sequence of functions of “Export to archive...”, “Import from archive...” and “Import to model...” 

replaces copy/paste across repositories. 

The imported product structure will be identical to the archived one, which may be a complete or a partial 

product structure, and includes copies of all files. 

When importing a model from an exported package and choosing the option “AP209” the following data 

will not be imported: 

1. Properties 

2. Approval types 

3. Methods 

To import this data, use the import-option “SIMDM MASTER”. 

 

Note: As an archive does not include access rights, the imported archive has only default access rights. 
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Note: If an archive contains STEP-files, these are not automatically imported into models of their own; 

they will only be imported like any other file as blobs. Before being able to validate or query such STEP-

files you need to execute the file context menu item “Import STEP”. The server will find the 

corresponding file and read it into EDM. After this, “Validate” etc. will become available. 

9.12 Child folders 
A product structure consists of a single top folder, the product structure folder, and zero, one or many 

child folders, also called subordinate folders. Folders are the containers for files and various kinds of 

meta data. Folders may have different types. Folders may be versioned and may be configuration 

controlled by baselining their versions. In fact, the SimDM browser does not distinguish between folders 

and folder versions; the children in a product structure are folder versions. 

Note: A folder may not have several parent folders; that is, the folder structure in EDMopenSimDM is 

not well suited to model bills of material where sub-assemblies may be used in several locations. 

9.12.1 New 

This function adds a new folder to an existing product structure, either directly under the top folder or 

below any other folder. Adding a new folder results in the automatic creation of the first version of this 

folder; this, however, does not show in the GUI. See chapter 9.13 for details of folder versions. 

The following dialog appears (see Figure 36) with the “New child…” context menu. Combo box “Class” 

contains a number of folder types (classifiers). Those types may be treated differently by the application. 

The icons of the created folder objects are different to carry the different semantics. 

The “Name” text field provides the identifier of the folder; this is a mandatory text value. The name 

appears aside the folder icon in the product structure. A folder may have several versions. Text field 

“Version” can be empty. In this case the version identifier will be generated by the application. 

 

Figure 36. Dialog to create child folder 

Text fields “Description” and “Comment” are optional and can be omitted. 
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9.12.2 Exclude from parent 

Several versions of a parent folder may have the same child folder. This command removes the child 

folder only from the current version of the parent folder, not from the other versions. To remove a child-

folder from all versions of a parent folder, see 9.12.3. 

9.12.3 Remove folder 

Selecting the “Remove folder” menu item triggers a confirmation message box to pop-up. 

If the selected child folder has only one version, the following message is displayed (see Figure 37). 

 

Figure 37. Child folder removal from all parent folder versions 

9.12.4 Copy 

“Folder → Copy” loads a copy of the folder and its underlying branches into memory for being pasted 

into another location. Meta data and files are not included. However, properties that have default values 

and are, thus, mandatory, are pasted with their default value – even if the default value has been replaced 

by the user in the copied folder. The original copy will not change at all. 

9.12.5 Cut 

“Folder → Cut” loads a copy of the folder and its underlying branches and meta data into memory for 

being pasted into another location. Files are not included. The original copy will be removed after pasting. 

The Cut-function can be cancelled by, for example, applying the Copy-function. 

9.12.6 Paste 

“Folder → Paste” creates a copy of a copied or cut folder and its underlying branches below the selected 

folder. Only folder structure is copied. Documents, user assignments, attached files, etc. are not copied. 

Copied folder have "Introduced" and "Changed" timestamps that represent the time when actual copy 

operation has been done.  

Note: The copy of a read-only folder will allow write access. 

Note: A copied or cut folder cannot be pasted outside of the product structure of the original folder. 

9.12.7 Paste link 

Pasting a copied folder as a link is like drag-and-drop of that folder; the action establishes a reference in 

the target folder to the copied folder. A link object appears in the "Details" view of the target folder. 

A double-click on the link object sets the product structure tree pointer to the source folder. 

A back (backward) link is included in the "Details" view of the source folder. 
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Figure 38. Link object in the detail view of a folder 

9.13 Folder version 
To capture the history of the development of a folder EDMopenSimDM applies the concept of versions 

of folders. When adding a new folder its first version is created automatically. 

Several versions of a folder can be modified in parallel. Parent-child relationships are always between 

the – in that context – current folder versions, not between the folders themselves. Baselines include 

folder versions, not folders. 

If a folder has only one single version, the folder name only is represented in "Tree" view and "Details" 

view. If the folder has more than one version, folder name and current folder version identifier are 

represented in square brackets in "Tree" view and "Details" view. 

9.13.1 Add folder version 

This functionality creates a version of the selected folder. The just created folder version becomes current 

instead of the selected one. The following dialog (see Figure 39) appears after choosing the "Versions" 

→ "Add folder version..." context menu item.  

Name and type of the selected folder will not change when adding a version to it. Name and tag of the 

folder version will appear in square brackets for the second (and all later) folder versions. 
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Figure 39. Create new folder version 

• "Version tag" – specifies the tag of the new version. If the text field is empty, version tags will be 

numeric: "1", "2", ... if the text field has value "alpha", new version tags will be "2 alpha", "3 alpha", ... 

until a different version tag is specified for one of the consecutive versions. 

• "Share file links" - if checked, all file objects assigned to the selected folder version will be copied to 

the new folder version.  

• "Copy tasks" - if checked, all task objects will be copied to the new folder version. 

• "Copy properties"- if checked, all property assignments will be copied to the new folder version. 

• "Children folders" - if checked, all children folders will be either shared (Share) between versions or 

they will be copied (Copy) to the new folder version. 

• In case of "Share" the new version references the same (identical!) children folders that the previous 

folder version referenced and still references. Changes to these children from one version will have 

the same effect for the other version. 

• "Copy folder links" - if checked, all folder references and file references will be copied to the new 

folder version. 

• "Back folder links" - if checked, all back links will be either moved (Move) between versions or they 

will be copied (Copy) to the new folder version. 

• "Cascade" - if checked, a new version will be created for the selected folder and all its parents; this is 

intended for folders that are children in a “finally approved” branch. 

• "Excluded items" - drop-down list to select items that shall not be included in the new folder version. 

• "Substitute in" - drop-down list of parent folders where reference to ancestor (as child) shall be 

replaced by newly created version; by default, all ancestor parents are added to the new version. 
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Example: 

There are two parent versions with one single shared child. 

(1) The user creates a new version of the children folder when "Substitute in" is empty (see Figure 40). 

 

Figure 40. Version of children folder when "Substitute in" is empty. 

Pink arrows are parent-child relationships. Green arrows show version relationships. Both child versions 

have two parents. 

(2) "Substitute in" has v.1 parent. In this case both children folders have one single parent. 

 

Figure 41. Version of children folder when "Substitute in" has parent v.1. 

 

9.13.2 Show version 

"Versions" →“Show version” allows you to change the current view of the selected folder to a different 

version in the main product structure panel. You will select the version from a list of currently not viewed 

versions. 

Note: “Show version” switches to a different version only temporarily. When refreshing the product 

structure, the system will show: 

- either the latest version 

- or the one that you selected as “Make preferable”; see 9.13.3 . 

 A version of a folder may also be displayed for itself in another product structure panel by using the 

folder context menu as shown below: 
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Figure 42. “Show version” dialog 

Selected folder has three versions: 1, 2 and 3. Current one is "1". Version "3" (bold font) will be displayed 

instead of version "1" because version "1" and version "3" belong to the same parent folder. Version "2" 

will be opened in a separate "Product Structure browser" panel because it belongs to a different parent 

folder. 

 

Figure 43. A folder version in its own product structure browser panel 

9.13.3 Make preferable 

Use "Versions" →“Make preferable” to select one version out of a set of versions of the same folder to 

make it displayed by default after login or Refresh. 

If “Make preferable” has not been selected for a set of versions, the most recent version will be displayed 

by default. 

9.13.4 Remove version 

A folder version is removed using the function for folder removal as there is no difference in principle 

between a folder and a folder version (see 9.12.3). 

9.14 File handling 
Files are a class of objects in SimDM; they are neither meta-data nor folders. Files do not appear in the 

product structure, but are always associated to a folder. It may be useful to create document folders and 

assign files to only those. Files have their own context menu, which is shown in Figure 44. 
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Figure 44. Files context menu for AP209 files 

 

The context menu for files consists of the following menu items: 

• “Open” – launches the application that opens the file (see 9.14.4) 

• “Open with” → “Select application....” – launches the MS Windows browser so that you can find the 

application that you want to open the file with (see 9.14.5). 

• “Download” → “Attached file…” – opens Windows file browser to let you select the location where 

the selected file shall be copied to 

• “Download” → “CAX file…” – is only available for files that were successfully converted to the 

VCollab CAX-format (see chapter 6); such files are not explicitly listed in the detail view. Opens 

Windows file browser to let you select the location where the CAX-file shall be copied to. 

• “Engineering query…” – opens dialog to specify a query into the selected file (see 9.20). This menu 

item is only available for AP209 files and only if they have been imported into a separate EDM model; 

for export packages that have been imported this is not the case. 

• “Validation” -> “Validate…” – starts a validation of the selected file against its EXPRESS schema 

(see 9.14.6). No further user input required. This menu item is only available for AP209 files and only 

if they have been imported into a separate EDM model; for export packages that have been imported 

this is not the case. 

• “Validation” -> “Open log” – downloads validation log and opens it. 

• “Validation” -> “Remove log” – removes validation log on the server 

• “Import STEP” – starts the import of a previously uploaded STEP-file. This menu item only appears 

for STEP-files that have been re-imported via an export package. After successful completion menu 

items “Engineering query…” and “Validate…” will appear. 

• “Import STEP” -> “Open log” – downloads import log and opens it. 

• “Remove” – removes selected file from the database after your confirmation. 

• “Copy” – copies the reference to the current file (see 9.15), not the file itself. A consecutive “Paste” 

(Paste link) will establish a two-way link between this file location and the location of the paste-

operation. 



EDMopenSimDM™ Application Reference Manual, R17 

 

2022-06-01  Page 57 

 

9.14.1 Assign and upload files 

Files may be assigned to all kinds of folders, not only to folders of type “Document”. The files of a 

selected folder are listed in the middle (Details) view of the “PS browser” panel. Use the “Details” button 

in the tool bar to show or hide the “Details” view (see Figure 16). 

Files from the local file system may be uploaded to the current server by the following three ways: 

• Via the “Upload…” context menu item on the selected folder. 

The file for upload is selected in the “Original name:” field (see Figure 45). 

• Via Drag-and-drop functionality. 

The file for upload is dragged from the “Local File Explorer” panel (View → Local File Explorer) 

and dropped into “PS browser” panel (“Tree” or “Details” view). 

• “Windows explorer” can be used instead of the “Local File Explorer” panel.  

Note: Where drag-and-drop is available, multiple files can be uploaded at the same time. The “Upload file” 

dialog can appear for each selected file. 

  

Figure 45. “New file -> Upload...” dialog 

The field “Original name:” represents the path to file that shall be uploaded. The “Select file” dialog 

appears when the “…” button is pressed. 

After file selection, the “Type” field displays automatically the textual file type name (see chapter 5.5). 

If the file extension is not defined in the “File associations” table, “undefined type” is displayed in the 

“Type” field. In this case the logical file type “Document” will be assigned to the selected file. You may 

change this behaviour by registering the file extension using the “Tools > File associations” menu item 

(see 5.3). 

The following file types trigger conversions of the input files to AP209: 
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- Nastran (recognized by file extension .bdf)  

- STEP-TAS (recognized by file extension .stp and by the schema name within the file) 

- 3D cloud of points (recognized by file extension .vrml). 

For such file types the uploading form in Figure 45 is extended by “Converter parameters” and “Get file 

summary”; see Figure 46. 

 

Figure 46 Extended form to upload a file 

 

Some file types with geometry data (STEP and NASTRAN) are during upload converted to the VCollab 

CAX visualization format; see chapter 6 for the assignment of applications to file extensions and chapter 

13 for possible errors during STEP-file import. Both the original file and the CAX-file are stored in the 

EDMopenSimDM database. The GUI, however, will only show the original file. 

 

Note: STEP-TAS files may contain design and analysis data. Both sections will here be converted to 

AP209 and both sub-models will be graphically displayed in a single tessellated model. 

 

Before starting the upload you may add the following file meta data, which are intended as additional 

data when archiving the file: 

Owner: In the owner field it is possible to enter a person or organization different from the 

uploading person as the owner of the file. If you check the check-box “Set current user as owner”, 

it will not be possible to enter anything in this field. 
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Original format: If the uploaded file is transformed from an original format, it is possible to enter 

the name of the original format in this field. 

Creating system: Denotes the original system that produced the file.  

Interface: Denotes the interface software that was used to convert from the original format, if the 

file was the result of any conversion. 

Operating system: Denotes the operating system requirements of the file. 

If files are dragged from Windows Explorer, the dialog shows the check box "Use the same meta-data 

for the rest of files". If it is checked all uploaded files will have the same meta-data (except file name and 

size); this dialog needs to be filled out only once for the entire group of dropped files. 

 

Note: If the dropped files are going to be subjects to conversions, this check box shall only be ticked if 

all files will use the same converter; for example, all files are NASTRAN bdf-files. Otherwise, some files 

will be uploaded without having been converted. To ensure that different converters will be triggered, 

fill in this dialog for each file. 

 

Click "OK" to start upload. Upload duration depends on file size; conversion to AP209 and to cax will 

increase upload time even further, possibly considerably. Finally, the uploaded file will appear in the 

Details-pane. 

The file context menu will give access to cax- and log-files. After selection of a file (single click), its 

metadata, like file size, will appear in the Properties-pane. 

Right after start of a file upload the file name appears in the “Details” view. This does not imply that the 

upload is completed already. Upload is an asynchronous process; it is completed when the progress bar 

in the lower left corner of the SimDM window disappears. In addition, the user is notified by an alert 

window (see Figure 47). 

 

Note: Upload time depends among others on the network capacity. 

 

 

Figure 47. Alert window after upload is finished 

9.14.2 New external file reference 

The "New file -> External link" command stores only the file path of the file in the EDMopenSimDM 

database, not the file itself. In addition, it stores file size and last modification time. The file must be 

possible to open for read from both the EDMopenSimDM client and the EDMopenSimDM server. It is 

only files in the local network with file path like "\\local_machine\folder_name\file_name.ext" that can 

be opened by this command. 
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When creating baselines that include references to external files, it is checked that the last modification 

date of the file is equal to the last modification date stored in the database. If the file is modified after the 

reference is stored in the database, a warning is given. The same test is performed when a referenced file 

is to be copied into an archival package. Here also a warning is given if the file is modified after the 

reference is stored in the database.  

For files that are converted to the cax-visualization format, the resulting .cax-file is stored in the folder 

of the external file. 

It is emphasized that referenced files are outside the control of the EDMopenSimDM system.  

9.14.3 Download 

Files from the server can be downloaded to the local file system by using “Download” context menu for 

the file object (“Details” view). The “Download” context menu has two items: “Attached file…” and 

“CAX file…”. “Attached file…” item is available for any uploaded files. “CAX file…” item is available 

only for files that where converted to CAX file during upload. 

“Download” requires selecting a local folder to download the file into. In this case standard dialog “Save 

file as…” appears. Download can take time for large files. When a file is downloaded, the user gets a 

notification as an alert window (see Figure 48). 

 

Figure 48. Alert window after file is downloaded 

9.14.4 Open 

“Open” downloads the selected file into a temporary folder on the client machine and opens the file by 

an appropriate viewer (see chapter 5.5). 

Note: Some of the file types (CAD/CAE, AP242/AP209) are automatically opened in the 

“EDMopenSimDM viewer” panel (see chapter 13), unless an external viewer was specified for these file 

types in Tools → File associations. 

9.14.5 Open with 

“Open with” menu contains one item for each specified external viewer in addition to the menu item 

“Select application…”.  

If only the file path of the file was uploaded into the database and not the file itself, the EDMopenSimDM 

client will try to open the file with the original file path and download it to the target file path. If the 

referenced file had been modified after the reference to it is stored in the EDMopenSimDM database, a 

warning is given.  

9.14.6 Validate 

Before archival, STEP-files shall be validated. The validation result files shall be included in archival 

packages. Such validations run against the constraints in the EXPRESS schema that the STEP-file is said 

to be compliant with.  



EDMopenSimDM™ Application Reference Manual, R17 

 

2022-06-01  Page 61 

 

This release of the SimDM browser allows you to validate AP209 files. Other STEP-files are not 

validated as their EXPRESS schemas are currently not available to the SimDM browser. 

Currently validation options can be specified (see Figure 49). 

 

Figure 49. Validation options 

All validations are done against constraints in AP209, and a report is created. The report is presented to 

you on request after completed validation; see Figure 50. 

 

Figure 50. Message after completed AP209 validation 

The report file is stored in the database. When repeating the validation, different validation options can 

be chosen. 

It is also possible to validate several STEP-files at the same time. Right-click (right-hand mouse) on a 

folder and select “Check STEP-files”. The following window will pop-up. 
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Figure 51. Information window for “Check STEP-files...” 

The application will then present the table in Figure 52with all SEP-files that may have been or may be 

subject to validation. The same table will appear again after all selected validations have been performed. 

 

Figure 52. Overview of STEP-files given by “CheckSTEP-files...” function 

9.15 Import into Product Model 
In support of typical engineering processes for design validation EDMopenSimDM introduces the 

capability of building comprehensive AP209 product models from partial ISO STEP data sets. The 

example of such an engineering process in Figure 53 leaves the core of current business practice 

unchanged; only recording and management of data is added for the sake of traceability, archival and 

retrieval and by the use of EDMopenSimDM. Such recording is done by “imports” into an AP209 

database to build up a comprehensive product model that consists of AP209 instances only. 
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Figure 53. Example engineering process 

 

9.15.1 Model federation and sub-models 

Such a product model is built from data sets in ISO 10303-21 files during file import. The data in the file 

will be stored as structured data; in addition, the system will store the P21 file itself. 

Files are imported one by one. A first P21-file will establish the AP209 product model in the database. 

The contents of subsequent files will get interconnected with the already existing product model. The 

result may be called a federated model. Each model in EDMopenSimDM, that is, each top folder in the 

Tree-view, manages zero or one product model. 

 

Note 1: One EDMopenSimDM database server may contain many federated models; the names of these 

federated models shall be unique. 

 

Each file contributes a sub-model to the product model. There is no practical limit to how many sub-

models a product model may consist of. As P21-files usually originate from commercial applications, 

their scope is given by those applications. Examples of sub-models are the satellite circles in Figure 54 

below. 
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Figure 54. A federated model consisting of sub-models and a link model 

 

P21-files that shall become sub-models of the federated AP209 product model are loaded using import 

wizards. The corresponding menu items are called “Import AP209 data…” and “Import gage 

definition…” and are available in the context menus of all folders, except the top folder. 

9.15.2 STEP compliance 

Only data that are compliant to ISO 10303-209:2014, that is, the EXPRESS schema  

AP209_MULTIDISCIPLINARY_ANALYSIS_AND_DESIGN_MIM_LF 

can be added to the product model in EDMopenSimDM. That exact schema name needs to be used in 

the P21-file. 

9.15.3 The process of building a product model 

Release R17 of EDMopenSimDM enables loading sub-models of types 

• Product structure, 

• Design, 

• Analysis,  

• Sensor definitions, 

• Physical test data, 

• Cloud of points and 

• Raster images as results of analyses or tests. 

Test definitions are not imported, but are created in the client from sensor definitions. 

Whereas loading a product structure is the required initial step, a single manually created folder is 

sufficient to start upon a product model. And although the sequence in the list above is most meaningful, 

sub-models may be added in different sequences. 

The following sub-chapters explain the assumptions of how EDMopenSimDM handles these sub-models 

and gives an overview of import and merge functionality. The specifics of the user interactions to import 

sub-models are detailed in chapter 9.15.4 “Use of the import wizard”; browsing them in the client is 

described in chapter 9.16 . 
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9.15.3.1 Product structure sub-model 

At first, a sub-model with product structure data needs to be imported; all subsequent imports are assigned 

to constituents of a product structure, an imported one or a manually edited one. Product structures are 

typically designed using PLM or CAD applications. A P21-file created by one of those applications is 

likely to be the first one to be loaded by the import wizard (see 9.15.4, below). The resulting Tree-view 

may look like the one in Figure 55. The P21-file itself will be stored in the folder that the wizard was 

started from, for example, in Figure 55 the folder “Assembly_winglet”. Each of the product structure 

folders will be assigned the meta data of the import, such as, date of import, user who performed it and 

description. 

 

 

Figure 55. Example of a product structure sub-model in the Tree-view 

 

Subsequent sub-models are typically loaded from one of the product structure folders, that is, by a right 

click (right-hand mouse) on the corresponding icon to execute menu item “Import native data…”. This 

association with the specific product structure node implies that all subsequently loaded data is valid for 

this assembly or part. Design and analysis data, for example, that may get associated with “Assembly 

winglet” in Figure 55, are, thus, supposed to be applicable for the complete underlying product structure. 

The correctness of this association is at the discretion of the user and is not validated by 

EDMopenSimDM. 

Imported product structure folders may offer slightly differently context menus from other Tree-view 

folders, which the user creates by the “Add child…” menu item.  

9.15.3.2 Design sub-model 

A design sub-model adds a shape representation to the product model. You may add zero, one or many 

shapes to the same product structure node. Each shape will be assigned a folder of its own, which you 
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may access, for example, to launch the textual or graphical browsing of the folder data; for details see 

chapter 9.16 . The imported P21-file will be associated with this shape folder icon, which will also host 

the meta data of the import. The first import will additionally create the “Designs” folder in the Tree-

view of the client, correspondingly to the “01_Design” folder in Figure 56. Subsequent imports of design 

sub-models may serve the purpose of providing alternative shapes to the initially uploaded one. The 

different shapes will be treated as if they were located in the same coordinate system. 

The system will initially not distinguish the purpose of a shape, for example, whether it represents the 

nominal or an idealized geometry. The user may indicate such purpose for human reading by choosing 

an appropriate name. Idealized shapes may be formally identified during imports of analyses. 

Shape representations cannot be versioned. The attempt to do so will result in a new version of the product 

structure node that owns the shape. This new version will, however, be limited to the one node itself; the 

branch below will not be copied. 

 

Note 1: In this release versioning of imported sub-models may not yet work as intended. 

 

 

Figure 56. Annotated example of sub-models for design, analysis and test in the Tree-view 

 

9.15.3.3 Analysis sub-model 

Different types of analyses may be run for a certain design. Also, the same type of analysis may be run 

many times, for example, for different load cases or with different meshes. Each such analysis is imported 

as a single file through the import wizard; see 9.15.4.3 . The imported analysis sub-model will be 

displayed by the folder icon that is specific for its type of analysis; it will also host the meta data of the 
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import. The first import will additionally create an “Analyses” folder in the Tree-view of the client; see 

Figure 56.  

During import, the user may associate one or several shapes with the analysis. These shapes are supposed 

to represent the idealized shapes that were used to derive the analysis mesh. The associations will be 

shown in the Details-view of the GUI as links to other folders (see 9.20.2 for details on linking folders). 

An example of a link between an idealized shape and an analysis is given in Figure 57. 

Analysis files may describe different aspects of an analysis model; mesh, load cases and analysis results 

are displayed in the GUI as sub-folders. These may be uploaded individually, that is, each in its own P21-

file; several such individual sub-models may – by the discretion of the user - be merged into one analysis 

folder. These sub-models can, however, not be versioned individually; a new version of a mesh, for 

example, will lead to a new version of the parent folder of mesh. Thus, one version of an analysis may 

only contain a mesh, whereas others may contain mesh, load cases and analysis results data. 

 

Note 1: In this release versioning of imported sub-models may not yet work as intended. 

 

After import the contents of the analysis sub-model may be viewed graphically in the VCollab browser 

(“Open with”) or may be queried (“Engineering query…”). 

 

 

Figure 57. Example of links among analysis, shape and test 

9.15.3.4 Sensor definition sub-model 

Before a part is put to structural or thermal tests, sensors and gages will be mounted to it. The information 

how to mount them, is recorded in a file that we call gage definition file; see Figure 58 for an example. 

The depicted file provides the following information, read from left to right: 

• identifier of an individual gage instance; 

• identifier of an individual element in an analysis model; 

• category of gage (displacement, acceleration, ...); 

• location of the gage on the element surface (top, bottom, mid); 

• the way the orientation (next parameter) is specified; 

• value(s) that define the orientation of the gage relative to the product; 

• values (usually x, y, z) that define the position of the gage on the product. 
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Thus, and most importantly, the sensor definition information depends on a specific analysis and its 

discretization into elements. It, therefore, relates to analyses that use the same discretization; there may 

be several of those. 

 

 

Figure 58. Example contents of a gage definition file 

 

On the other hand, a single gage definition may be the basis of several test cases, as each test case may 

use a subset of the gages of the gage definition file. Thus, before specifying test cases, a gage definition 

file needs to be imported into EDMopenSimDM. 

The first import of a gage definition file into a product structure node creates a folder like the 

“03_Structural tests” folder in the Tree-view of the client; see Figure 59. It also creates the folder with 

blue background in the same figure. The name of this folder is provided by the user during execution of 

the wizard. It represents the combination of a specific product instance under test, a set of gages that are 

mounted to this product instance and a finite element mesh; it should be correspondingly chosen by the 

user. If one of these three components changes, the folder will change version. Thus, a second GDF 

import to the same product structure node will result in a new version of the folder “Product under test 

with gages”.  

During import the user will identify the analysis that the gage definition is valid for. The system will 

display this relationship by a link symbol in the Detail-view; see the reference to “Linear models [2]” in 

Figure 59. It is, thus, not possible to import a GDF-file to a part that has no analysis folder, yet. 
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Figure 59. Example of structural test sub-models in the Tree-view 

9.15.3.5 Test results sub-model 

The stages between importing gage definitions and importing test results are “defining tests” and 

“predicting test results”. EDMopenSimDM provides user functionality for both these intermediate stages. 

The test definition stage will create the test case folder, which in Figure 59 are called “Test 1”, “Test 2” 

etc. . If these stages were not done before test results are imported, this import will create them. 

Subsequent imports to the same test case will result in new versions of the test result folder. 

9.15.4 Use of the import wizards 

The import wizards are EDMopenSimDM functions that guide the user through the import of data files 

from different engineering domains and in different formats to a federated model. All import wizards are 

available from the PBS folder context menu and its item Import native data (Figure 60). 

A federated model is initialized by the Import design method and only by this. That is, all subsequently 

started wizards depend on the Import design method having been completed successfully. Import design 

extracts the main product breakdown structure from the assembly structure in a CAD STEP file (typically 

in AP203, AP214 or AP242 format). 

  

Figure 60. Import wizard entries in folder context menus 

A wizard consists of a sequence of GUI forms that guides the user through the import process and the 

integration of the imported data into the federated model. Each sub-chapter of this chapter is dedicated 

to one import wizard; it describes each step of the wizard. 
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Besides import wizard there are wizards for the projection of raster images on to CAD and FEM 

models; see chapter 9.19 . 

Selected files will be uploaded to the EDMopenSimDM server and into a temporary model to await 

user interaction and confirmation. The duration of the import operation depends largely on the size of 

the imported file; files below 100 MB may be imported in seconds, above 100 MB in minutes. 

You may then browse the pre-imported data and select which data shall be added to the product model. 

After user confirmation and final import, the tree view will be updated, and the imported data (if any) 

will appear as folder icons; different icons are used for different types of sub-models. The temporary 

model will be removed from the database. 

The file that was identified for import will after import be stored - as a file - in the folder that the 

wizard was triggered from. If, for example, an import was triggered from the context menu of the 

folder with name “parent” in Figure 63, the STEP-file will be stored as a file in the “parent”-folder; see 

Figure 75 for an example. 

Imported folders have additional meta-data compared to manually created ones. These additional data 

relate to the AP209 representation of the folder and are also displayed in the Properties-view; see Figure 

61, below. 

  

Figure 61. Additional meta-data for folders of imported AP209 sub-models 

 

Note 2: All folders that result from AP209 import need to support the restriction that all direct children 

of a folder shall have different names. 

9.15.4.1 Import of product structure 

Product structures are imported by the wizard called “Import design”. After an information page and the 

file selection page you will – after some processing time – be presented for a pre-view of the file contents. 

For a file with a rich product structure, these contents may look like in Figure 62. 
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Figure 62. Design import wizard – product structure model pre-view 

 

Imports of product structures result in folders of types “assembly” or “part”. Folders of type “assembly” 

may have children of type “part” (or “assembly”). Names of the product structure folders are retrieved 

from the imported data. 

 

 

Figure 63. Design import wizard - Tree-view after product structure import 

 

If you in the wizard accept this product structure and move to the next wizard page, you are asked to 

confirm the scope of the sub-model; see Figure 64. You may want to override the information on the file 

so that the sub-model data will be different and in accordance with your evaluation of the file contents. 

 



EDMopenSimDM™ Application Reference Manual, R17 

 

2022-06-01  Page 72 

 

 

Figure 64. Design import wizard sub-model selection – product structure 

 

Subsequently you need to decide which product model the file for import shall be assigned to. Figure 65, 

below, shows that you may create a new product model, by writing your name for it into the text box, or 

select an existing one from the drop-list. The name must start with an underscore symbol; besides 

underscores only letters are allowed. This name, or identifier, is used as a prefix for the sub-models that 

are subsequently added to the federated model. This name cannot be used as folder name in the product 

breakdown structure. 

 

 

Figure 65. Assigning an import to an existing or new federated model 
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9.15.4.2 Import of design shapes 

Also design models are imported by the wizard called “Import  design”. A folder with names "Designs" 

is created during import of the first design sub-model for a product structure folder. "Designs" is a 

container for children folders of type “design” that represent product shape representations. If a 

"Designs"-folder has several children, they will be interpreted as alternative shapes of the same design. 

For example, one child may represent nominal shape, whereas others may represent idealized shapes; 

this specific distinction, however, will first be recorded in the AP209 product model during import of an 

analysis sub-model. 

To import additional shapes start the import wizard from an existing shape, its “Designs”-folder or the 

parent product structure folder. In the example of Figure 66, the existing shape was chosen. 

 

 

Figure 66. Design shapes in the Tree-view 

 

The “PLM data” page of the import wizard shows in Figure 67 with its pre-view that the file contains a 

single shape. 
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Figure 67. Design and analysis import wizard – design model pre-view 

 

The last step of the import presents a model summary; see Figure 68. The user may decide which of the 

sub-models shall be imported. Names can be edited; name conflicts with existing nodes need to be 

resolved manually. 

 

 

Figure 68 Import design – summary of a STEP-TAS file with design and analysis data 
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9.15.4.3 Import analysis 

Analysis files are imported by the wizard called Import analysis. The import wizard can be started from 

an existing shape, its Designs-folder or the parent product structure folder.  

9.15.4.3.1 Step 1 – Analysis file selection 

When performing Import analysis, the user is required to select a STEP P21 file or a Nastran file.  

- Accepted schemas for STEP files are 

o AP209_MULTIDISCIPLINARY_ANALYSIS_AND_DESIGN_MIM_LF (AP209) 

o TAS_ARM (STEP-TAS) 

- Accepted for Nastran are Bulk Data Format files (.bdf, .nas, .dat) 

 

 

Figure 69 Import analysis – file selection 

 

Note: STEP-TAS files may contain design and analysis data. Both sections will here be converted to 

AP209 and both sub-models will be graphically displayed in a single tessellated model. 

9.15.4.3.2 Step 2 – File summary 

If a Nastran or STEP-TAS file is selected, the user may choose to load a summary of the file’s content. 
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Figure 70 Import analysis – native analysis file summary 

9.15.4.3.3 Step 3 – PLM data 

This step (Figure 71) presents the product structure data after conversion to AP209, that is, derived from 

the resulting AP209 model. 

 

 

Figure 71 Analysis import – analysis model pre-view (PLM data) 

9.15.4.3.4 Step 4 – Link to design 

If an alternative design has been imported for the selected Part or Assembly, the user can choose – 

optionally - to link the analysis to one shape that the system then will interpret to be the idealized shape 

(Figure 72) of the imported analysis. Otherwise this wizard step is skipped. 
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Figure 72 Analysis import – link analysis to idealized shape 

 

If several nominal shapes are present in the current Part or Assembly, the user is asked to – optionally -

select one of these as the nominal shape for this analysis (Figure 73). Otherwise this wizard step is 

skipped. 

 

 

Figure 73 link analysis to nominal shape 
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9.15.4.3.5 Step 5 – Analysis summary and final import selection 

The last step of the import presents a model summary; see Figure 74. The user may decide which of the 

sub-models shall be imported. Names can be edited; name conflicts with existing nodes need to be 

resolved manually. 

 

Figure 74 Analysis import – import analysis summary 

 

After the import has been confirmed, and if this is the first analysis added to this part or assembly in the 

breakdown structure, a folder Analyses is added as sibling to the Designs-folder, as shown in Figure 75. 

In this example, a sub-folder linear_static_analysis is added to Analyses, which reflects the type of 

analysis. The link to the idealized design shape is shown as a folder link in the right-hand panel of the 

figure. 

 

Figure 75 Analysis import – PBS after analysis import 
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Each folder of type Analysis is broken down into Analysis Results, Load Cases and Meshes, to which 

sub-models may be assigned. A Mesh-folder, for example, may have several sub-folders. 

An AP209 analysis file may also include material data. Material is in STEP represented as a product. In 

EDMopenSimDM these material products are listed as Part nodes in the Analyses folder; the node with 

the name “1” is an example of this (the name originates in this case from a Nastran material card ID). 

9.15.4.4 Import analysis results 

Analysis results are imported by the wizard called Import analysis results.  

9.15.4.4.1 Step 1 – Analysis results file selection 

The supported file formats for the import of analysis results (see Figure 76) are: 

- Nastran output2 file (.op2) 

- Nastran punch file (.pch) 

- ESATAN HDF5 result file (.TMD, .TMD2, .hdf) 

 

 

Figure 76 Analysis results import – file selection 

9.15.4.4.2 Step 2 – Analysis results file summary 

After the file is uploaded to the server, the user may choose to review a summary of the file’s content 

(Figure 77).  
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Figure 77 Analysis results import – native file summary 

9.15.4.4.3 Step 3 – Link to analysis 

The user is required to select an analysis to which the results are imported (Figure 78). 

 

 

Figure 78 Analysis results import – link to analysis 

9.15.4.4.4 Step 4 – Additional step for ESATAN files 

ESATAN HDF5 files contain result data for many steps; these data sets may be very large. The user may 

specify that only a selection of the result steps is imported using the following parameters (Figure 79): 
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- First step – The first analysis step to be imported 

- Last step – The last analysis step to be imported 

- All steps – If checked, the last step to be imported is the last available step in the model 

- Every … step(s) – Increment of included steps 

Example: For a model containing 10 steps. If first step is 2, last step is 6 and nth step is 2. 

The steps 2,4,6 will be imported (converted to AP209). Checking All steps checkbox will 

then also include steps 8 and 10. 

 

 

Figure 79 Analysis results import – options for ESATAN result files 

 

9.15.4.5 Gage definition import 

9.15.4.5.1 Step 1 – File selection 

Start the import wizard from a part or an assembly type folder. The first step is the selection of a gage 

definitions file (.gdf); see Figure 80. 
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Figure 80 Import gage definitions – file selection 

9.15.4.5.2 Step 2 – Gage definitions file summary 

After a .gdf file has been selected its content is summarized in a table (Figure 81).  

 

 

Figure 81. Import gage definitions – view of the native GDF-file contents 

 

9.15.4.5.3 Step 3 – Tested part name 

In this step the user creates an identifier of the tested part. This identifier identifies the physical part in 

its testing environment. 
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Figure 82 Import gage definitions – tested part name specification 

9.15.4.5.4 Step 4 – Link to analysis 

A set og gage definitions shall be linked to one analysis model (Figure 83). This analysis is expected to 

contain the elements that are referenced by the .gdf file (see “El.”-column in Figure 81). Thus, analysis 

data need to be imported before gage and test definitions can be added. 

 

  

Figure 83 Import gage definitions – link to analysis 
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9.15.4.5.5 Step 5 – PLM  data 

During the gage definition import, sensors are created in the AP209 structural test model. After import, 

the following GUI page (see Figure 84) shows the summary of the products created (this includes sensor 

types, sensors, and sensor components). 

 

 

Figure 84 Import gage definition – gage definitions model pre-view 

After import, a node of type product_under_test with the identifier given in the wizard, is created in the 

product breakdown structure (Figure 85). The wizard adds a link-object to the related Analysis-folder 

into the Details-view in the middle. 

If this is the first .gdf file imported, a parent folder Structural tests is added as sibling to Designs and 

Analyses. 

 

 

Figure 85 Import gage definition – PBS after import 
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After a Structural tests model has been generated from a GDF import, sensors can be displayed on the 

associated mesh by using VCollab functionality. Select Show Gages from the context menu of a 

product_under_test folder or double-click on the folder. A CAD model of sensor icons will be generated 

and opened in the viewer. A sensor CAD model will show one axis per sensor component (or leg) and 

one additional axis to indicate the normal direction out of the sensor surface. 

 

For visualizing sensors, such as gages, on a mesh, see 9.17; this functionality depends on the availability 

of VCollab. 

 

Note: Analysis data need to be imported before gage and test definitions can be added. 

9.15.4.6 Create test definition 

For each run of the structural test environment a test needs to be defined; that is, the test shall be assigned 

an identifier (Test definition ID), a related load case in an analysis, and a set of sensors. The wizard 

“Create test definition” provides this functionality. The wizard is started from an existing 

product_under_test folder. 

 

Note: Analysis data and gage definitions need to be imported before this wizard can run. 

 

9.15.4.6.1 Step 1 – Related analysis model 

The user is asked to select an analysis model. This analysis model needs to contain the load case the new 

test definition will relate to. 

 

 

Figure 86 Create test definitions - link to analysis 

9.15.4.6.2 Step 2 – Related analysis load case 

The user is asked to select one of the load cases found in the previously selected analysis model (Figure 

87). For the correlation tool to be able to plot correlation plots between analysis and test data, this load 

case should contain analysis results. The results can also be imported at a later stage using the Import 

analysis results wizard. 
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Figure 87 Create test definitions - select load case 

 

9.15.4.6.3 Step 3 – Sensors used in test 

Available sensors are listed (Figure 88). By default, all sensors are selected (Use sensor column) to be 

imported. The user can select which sensors are used in the current test, that is, sensors which deliver 

measurement data during the test. 

 

 

Figure 88 Create test definitions - available gages 

9.15.4.6.4 Step 4 – Test ID 

The user sets an identifier for the created test (Figure 89). This identifier needs to be unique within the 

current product_under_test node. It will be used as the name of the new Test definition node in the 

product breakdown structure. 
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Figure 89 Create test definitions - test definition ID 

 

9.15.4.7 Import test results 

Structural test results are delivered in formats that are specific to the software that records test 

measurements. Import of these data must not only interpret a test results file, but also needs to map 

electrical channels used to record the test results with sensor identifiers that deliver their data through 

these channels. 

 

The supported formats are: 

- Universal File Format (.unv) 

o Requires a .map file for mapping between sensor identifiers and IDs in the unv file.  

o Support of .unv/.map is implemented for files from Siemens Simcenter Testlab. 

- Comma separated file (.csv) 

o Requires a .gcm file for mapping between sensor identifiers and IDs in the csv file. 

The wizard is started from an existing folder of type test_case. 

9.15.4.7.1 Step 1 - Test result file selection 

In the first step, the user selects a .unv or .csv file (Figure 90). The format of the selected file will affect 

subsequent steps.  
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Figure 90 Import test results - select file 

9.15.4.7.2 Step 2 – Select sensor mapping file 

9.15.4.7.2.1 CSV and GCM 

If a .csv file was selected in the previous step, this step will ask for a .gcm file. Its content is presented 

as a table (Figure 91). It is related to the current test case. 

 

Figure 91 Import test results – specify gage channel mapping and test ID 
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9.15.4.7.2.2 UNV and MAP 

If a .unv file was selected in the previous step, this step will ask for a .map file (Figure 92). 

 

Figure 92 Import test results - select .map file 

9.15.4.7.3 Step 3 – Select options 

9.15.4.7.3.1 CSV and GCM 

If .csv and .gcm files were selected in the previous steps. The following options need to be specified (see 

also Figure 93): 

- Channel ID row – The row number in the .csv file containing the identifier for the channels 

- Number of metadata rows – The number of rows in the .csv file before the first result values row 

- Result data type – The type of result data in the .csv file 

- Time stamp format – The format of the time stamps in the first column of the csv file 

(https://en.cppreference.com/w/cpp/io/manip/get_time) 

o In addition to the format specifications from the link above, the format %fs specifies that 

the time stamps are in seconds as decimal (real) values. 

https://en.cppreference.com/w/cpp/io/manip/get_time
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Figure 93 Import test results - options for CSV file import 

9.15.4.7.3.2 UNV and MAP 

For .unv and .map files, no further input is requested from the user. 

9.15.4.7.4 Step 4 – Select analysis model 

The analysis model related to this test need to be selected (Figure 94). 

 

Figure 94 Import test results - select analysis model 

9.15.4.7.5 Step 5 – Result data identifier 

The user needs to specify an identifier for the folder that is created in the product breakdown structure 

(Figure 95). This name should identify the results imported and will be the name of the child node of the 

selected Test definition node. 

Finally, the imported file is stored. The file contents are stored explicitly in the federated model as AP209 

instances. Thus, after the import of test results, it is possible to investigate the relationships between these 

measured results and the calculated simulation results. See chapter 14 for instructions on how to use the 

correlation plot application. 
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Figure 95 Import test results - result identifier 

9.15.4.8 Import optical analysis image 

In the context of this import method, the imported image is intended to represent the results of an optical 

analysis. The import wizard allows the user to define a new optical analysis with the imported image as 

the analysis result; an imported image may also be stored as an additional result of an existing optical 

analysis 

9.15.4.8.1 Step 1 – File selection 

The optical analysis image file selection (Figure 96) is restricted to these extensions: 

- .jpg, .jpeg 

- .tif, .tiff 

- .png 

- .csv (cells in csv files are interpreted as pixels, where each value is the result value for that 

pixel). 

 

Figure 96. Import optical analysis image – specify image for import 
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9.15.4.8.2 Step 2 – Specify identifiers 

In this step the user either selects an existing optical analysis folder or specifies a name for a new one 

(Figure 97). A unique identifier needs to be specified also for the imported raster image. The identifier 

of the analysis folder should represent the analysis that produced the raster image. The raster image 

identifier identifies this raster image as a result from that analysis. 

 

Figure 97. Import optical analysis image – optical analysis and image folder creation 

This wizard will result in an Optical analysis folder as a child of an Analyses folder, and with a raster 

image folder as a child. 

9.15.4.9 Import thermal camera image 

Thermal camera image import works the same way as the optical analysis image import (see chapter 

9.15.4.8).  

In the context of this import method, the imported image is intended to represent the image from a thermal 

camera. The import wizard allows the user to define a new Testing product with the imported image as 

the test result; an imported image may also be stored as an additional result of an existing thermal testing 

product. 

9.15.4.9.1 Step 1 – File selection 

Raster image file selection (Figure 96) is restricted to these extensions: 

- .jpg, .jpeg 

- .tif, .tiff 

- .png 

- .csv (cells in csv files are interpreted as pixels, where each value is the result value for that 

pixel). 

9.15.4.9.2 Step 2 – Specify identifiers 

In this step the user either selects an existing testing product folder or specifies a name for a new one 

(Figure 98). A unique identifier needs to be specified also for the imported raster image. The identifier 
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for the testing product folder should represent the physical object in its testing environment while the 

thermal raster image is taken. The raster image identifier identifies this raster image as a thermal test with 

a raster image result. 

 

Figure 98. Import Thermal camera image – thermal product and thermal test folder creation 

This wizard will result in a Testing product folder as a child of a Tests folder with name Thermal tests. 

The Testing product folder has a Thermal test folder as child with a raster image folder as a child. 

9.15.4.10 Import Cloud of Points 

Cloud of points result typically from 3D scanning of physical products; this includes videogrammetry. 

Currently the only supported file format is .vrml/.wrl (Virtual Reality Modeling Language). 

9.15.4.10.1 Step 1 – File selection 

The user needs to select the .vrml or .wrl file to be imported (Figure 99). 
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Figure 99 Import cloud of points - file selection 

9.15.4.10.2 Step 2 – File summary 

After the file has been imported, the user may click Get summary to generate a summary of the original 

file content (Figure 100). 

 

 

Figure 100 Import cloud of points – file summary 

9.15.4.10.3 Step 3 – Cloud of points identifier 

In this step, the user needs to specify an identifier for the resulting AP209 model. The model will be 

represented as a Cloud of points folder that is a child of a folder named Re-engineering. 
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Figure 101 Import cloud of points - model identifier 

 

9.16 Browsing product models 

9.16.1 AP209 representation 

Imported sub-models may be browsed using the context menu entry “Browse AP209 meta-data…” that 

is depicted in Figure 60. The view that is then presented is specific to the folder that the function was 

launched from. The content is similar to the pre-view pages of the wizards, except that the browser shows 

the integrated data set, that is, the contents of all sub-models and their interconnections. See the example 

in Figure 102 with sub-models of product structure, design, analysis and gage definitions all in one view. 
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Figure 102. Resulting view of function “Browse AP209 meta-data…” 

 

9.16.2 Double-click actions 

For the following types of sub-models of the federated product model, domain specific actions have been 

implemented that are launched by double clicks on the respective folders: 

• Design: These folder types contain single design-models. The cax-representation of such model 

is sent to VCollab for graphical presentation. 

• Shape_definition: This may be a collection of design-folders. The contents of all those sub-folders 

will be sent to VCollab for presentation in the same view. 

• Mesh: Similar to shapes, double-click on mesh sub-folders will present the single underlying 

mesh in VCollab, whereas double-click on the parent folder “Meshes” will present all underlying 

meshes in the same VCollab view. 

• Load Cases: Double-click will launch the engineering query called Nodal Load Query (see 

9.20.1.10) with a parameter set that fits the current location in the product structure tree. 

• Product under test: Double-click will launch the correlation plot application. 
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For all other folder types, a double-click action will trigger the next lower level of folders to open or 

close. 

9.17 Engineering queries into product models 
Chapter 9.20 describes how engineering queries can be executed against AP209 files after those files 

have been uploaded to EDMopenSimDM. 

Engineering queries may also be executed against AP209 models that have been imported using the 

AP209 import wizard. Such imported models are part of a product model with potentially many sub-

models, each of which resulting from an import wizard process. Thus, the engineering capability has 

been extended to also be launched from a folder context menu, as a folder represents a sub-model. In 

addition, the user may choose whether to query just the selected folder or the entire product model. The 

latter will result in a list of all sub-models with their individual query results. See the two options in the 

context menu in Figure 103: 

• The “AP209 model” option launches queries for the selected sub-model only. 

• The “Product model” option launches queries for the entire product model. 

An example of the result of a Model Query into a product model is in Figure 104. All of the types of 

engineering queries that are described in chapter 9.20 may be executed against the product model. 
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Figure 103. Engineering queries – into the product model 

 



EDMopenSimDM™ Application Reference Manual, R17 

 

2022-06-01  Page 99 

 

 

Figure 104. Engineering queries – result of a Model Query into a product model 

 

9.18 Visualizing sensors on mesh 
After a Structural Test Model has been generated from a GDF import (see 9.15.4.5), sensors can be 

displayed on the associated mesh.  

By either, selecting Show Gages from the context menu of a product_under_test folder, or double-

clicking on the folder, a CAD model of sensor icons will be generated and opened in the viewer. A sensor 

icon consists of one axis per sensor component (or leg) and one additional axis to indicate the normal 

direction out of the sensor surface. 
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Figure 105 Sensor displayed in viewer (without associated mesh) 

 

The sensors may be shown on the mesh by displaying the mesh in the same VCollab window that already 

shows the sensors. 

 

Figure 106 Sensor displayed in viewer (with associated mesh) 

 

9.19 Wizards for raster image projection 
There are two uses of raster image projection in EDMopenSimDM: 

1. Projecting a raster image on a shape (CAD or mesh) to visualize it 

o The visualization is represented by a generated mesh with the raster image pixel values 

converted to result values applied to the mesh as nodal results. 

2. Mapping of raster image values on mesh to generate thermal loads 

o The result is raster image pixel values converted to result values and then applied as 

thermal loads onto the nodes of the mesh that the image is projected on to.  

Both functionalities are available from the context menu of folders of type Raster image as: 

- Project > Project image 

- Project > Map to nodes 

9.19.1 Projection on shape 

A raster image may be projected onto a CAD model. The projection is an orthographic projection, 

meaning that FOV (field of view) is not taken into account. 
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The resulting projection can be visualized in VCollab, optionally together with the shape that the image 

was projected on. 

9.19.1.1 Step 1 – Shape selection 

The user needs to select one of the available shapes (Shape definition or Analysis node type); this will be 

the shape that the raster image will be projected onto. The wizard lists shapes (or models) (see Figure 

107) that are children of the first Assembly or Part parent node of the Raster image that the wizard was 

started from. 

 

 

 

 

Figure 107 Raster image projection - shape selection 

9.19.1.2 Step 2 – Options 

The user needs to specify a set of parameters that defines how the projection should be performed. The 

specified parameters can be saved locally by clicking Save As; they may be loaded by the Open-button 

(Figure 108). 
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Figure 108 Raster image projection - options 

Below is a description of all available parameters in the wizard (Figure 109): 

Table 1. Raster image projection – Parameters description 

Parameter Description 

Result type The type of result the image pixels represents (Temperature, radiation, 

displacement) 

Image type RGB – specifies that this is a colored image,  

Greyscale – specifies that this is black and white image 

Color scaling  

(red, green, blue, 

min.result, 

max.result) 

If image type is RGB the result value is calculated from a pixel color 

using the following formula: 

result = min + (max - min)*(Red*pixel.red + Green*pixel.green + Blue*pixel.blue) 

 

If image type is greyscale the following formula is used: 

result = min + (max - min)*pixel.value 

 

Red, green, blue are normalized to represent a unit vector before 

applied in the projection module. 

Elements per edge The image is discretized to a rectangular mesh before projected. This 

option specifies the number of elements per edge for the mesh (total 

number of elements is this number of elements per edge ^ 2) 

Size (x, y, type) If size type is set to Image size these values specify the size the of the 

generated rectangular mesh before projection.  
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Parameter Description 

 

If size type is set to Pixel size, these values specify the size of each 

pixel in the image. 

 

The size values are in units of the target model (the model projected 

onto). 

The X (first) component refers to the direction of the width of the 

image. Y (second) component refers to the height direction. 

Position (x,y,z) The position of the center of the image in the frame of reference of the 

target model. 

Normal (x,y,z) The normal or projection direction of the image, in the frame of 

reference of the target model. The vector is normalized before applied. 

X-direction The x-direction direction of the image, in the frame of reference of the 

target model (the direction of the width of the image). The vector is 

normalized before being applied. 

9.19.1.3 Step 3 – Identifier 

The user needs to specify an identifier for the resulting Projection folder in the product breakdown 

structure. This identifier should identify the projection of this raster image onto the specified shape. The 

identifier has a default value of “Projection <counter> to <shape folder name>”. 

 

Figure 109 Raster image projection - specify folder name 
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9.19.2 Mapping of raster image to nodes wizard 

Raster image pixels can be mapped to nodes on an existing mesh of an analysis model. This is available 

from Project > Map to nodes in the context menu of a Raster image node. 

Similar to raster image projection to a CAD-model (chapter 9.19.1) this is done by orthographic 

projection, meaning that FOV (field of view) is not taken into account. 

The result of such mapping is three files: 

- loads.csv 

- This file lists the IDs of the nodes that have been mapped to the raster image and the 

resulting value (pixel value converted to result value) for each node. 

- loads.bdf  

- Contains the same data as loads.csv, but as TEMP Nastran bulk data cards, where the 

result value is applied as a load onto the specific nodes. 

- loads_mesh.bdf 

- Contains the same data as loads_mesh.bdf, but adds the full mesh of the model that the 

image was mapped onto. Note that the mesh in this file is a triangulation (only triangle 

and tetrahedron elements) of the original mesh, which is used in the projection algorithm.  

- This file can be opened in VCollab to visualize the applied thermal loads. 

The steps of this wizards are the same as in chapter 9.19.1, Projection on shape. 

9.20 Engineering queries 
AP209 models can be queried. The queries browse through the contents of a single file; this is describes 

here. Queries may also be used to browse through the contents of federated product models; see chapter 

9.17 for details. The file must have been uploaded as a STEP-file into EDMopenSimDM so that it exists 

as a model, not only as a file. This import will usually have taken place as part of the conversion to CAX. 

The “Engineering query…” menu item will open the panel that is shown in Figure 111. 

The following queries are included in this release: 
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Figure 110. Queries implemented in this release 

The input fields in Figure 111 may change title with the selected query. Object ids are specified in these 

text input fields. The ids must be separated by space; ids that contain spaces must be enclosed by single 

quotes. Numerical ids can be specified as a range with a dash between the minimum and the maximum 

range value. Example: 

            SPC_3.0 12 13 21  120 -123 òLoad case 1ò 

 

The above line specifies the following ids: SPC_3.0, 12, 13, 21, 120, 121, 122, 123 and Load case 1. 

 

Figure 111. The engineering query panel is to the left 

Maximum values: the query will present maximum values (only applicable to some queries) 

Minimum values: the query will present minimum values (only applicable to some queries) 

In case of survey queries: 

For each specified node over all specified load cases: finds maximum or minimum for each 

specified object over all specified load cases 

Over all specified nodes and specified load cases: finds maximum or minimum of all specified 

objects and load cases 

Execute: starts the query 
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Get HTML / Get CSV: current query result can be exported into a HTML-file or a csv-file. 

Engineering queries present their results textually in a HTML window. Common for all engineering 

queries is that input parameters are object ids and that the query returns information about these objects. 

There are three different types of engineering queries. These are: 

1. Queries that return information about objects where you specify object id(s).  

2. Queries that return information about objects with respect to load cases. You specify both objects 

id(s) and load case id(s). The load case id(s) are selected from a list of all load case ids in the 

AP209 model.  

3. Maximum or minimum tensor value surveys. You specify either maximum or minimum type of 

survey by a radio button. The survey finds maximum or minimum by analyzing the specified 

objects in the specified load cases. One variant of the surveys finds maximum or minimum of all 

specified objects and load cases. Another variant finds maximum or minimum for each specified 

object over all specified load cases.  

9.20.1.1 Model Query 

This query returns information about FEA models. The query key is the fea_model ID.   

 

The information displayed for each model is: 

• Total number of nodes, total number of coordinate systems, total number of each type of element 

and total number of elements.  

• Total number of control load cases  

• For each control load case: Total number of constraints and applied loads differentiated on 

variable type (pressure, etc.)  

• For each result load case indicate the existence of:  

o Deflections  

o Stresses  

o Strains  

o Element Forces  

9.20.1.2 Node Query 

This query returns information about the nodes that you specify in the input field. The query returns a 

table with one row per node. The table has the following columns: 

• Node ID:  the id of the node. 

• Node type:  the subclass of node.  Either Node, Dummy Node, Geometric Node. 

• Coordinate system ID:  the ID of the coordinate system used to found the node (see clause 5.6.2 

of 10303-104 for more details). 

• Coordinate System Type:  Either Cartesian, Cylindrical, or Spherical. 

• Coord1, Coord2, Coord3:  The coordinates in point subtype that specifies the position of the node.  

9.20.1.3 Element Query 

This query returns information about the elements that you specify in the input field. The query returns 

a table with one row per element. The table has the following columns: 

• Element_ID – the id of the element 
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• Type – “Volume_3D”, “Volume_2D”, “Curve_3D”, ..etc. 

• Order – For those element types where topology order is relevant: “Linear”, “Quadratic” or 

“Cubic”. 

• Shape – For “Volume_3D” elements this column can be either "Hexahedron", "Wedge", 

"Tetrahedron" or "Pyramid". For "Volume_2D" or "Surface_3D" elements the column cn be 

either "Quadrilateral" or "Triangle". 

• Property_ID – ID of the property information of the element. 

• Material_ID – The id of the element material. It is also a link to the query displaying this 

information. 

• Node_List – The node IDs of the nodes attached to the element. It is also a link to the node query 

displaying information about these nodes. 

9.20.1.4 Curve Element Property Query 

This query returns information about the curve element properties the IDs of which are specified in the 

“Curve Element Property ID(s)” input field.  The information displayed is: 

• Description 

• Cross_sectional_area 

• Shear area 

• Second moment of area 

• Torsional constant 

• Warping constant 

• Location of Centroid 

• Location of shear centre 

• Location of non structural mass 

• Non structural mass 

• Polar moment 

In addition information about End Offsets and End Releases is displayed. 

9.20.1.5 Surface Element Property Query 

This query returns information about the surface element properties the IDs of which are specified in the 

“Surface Element Property ID(s)” input field.  The information displayed is: 

• Property_ID 

• Offset 

• Non_structural_mass 

• Non_structural_mass_offset 

• Thickness 

• Bending_thickness 

• Shear_thickness 

9.20.1.6 Point Element Property Query 

This query returns information about the point element properties the IDs of which are specified in the 

“Point Element Property ID(s)” input field.  The information displayed is: 
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• Element_ID 

• Matrix_Type 

• Mass Matrix 

• Moments of Inertia 

• CoordSys_ID 

• Offset Vector 

9.20.1.7 Directionally explicit Element Property Query 

This query returns information about the directionally explicit element properties the IDs of which are 

specified in the “Directionally explicit Element Property ID(s)” input field.  The information displayed 

is: 

• Property ID 

• Coordinate System ID 

• Freedom 

• Coefficient 

This query is not implemented, yet. 

9.20.1.8 Material Property Query 

This query returns information about materials the IDs of which are specified in the “Material ID(s)” 

input field.  The information displayed is: 

• Material_ID 

• Material_Type(s) 

• Linear elasticity 

• Mass density 

• Tangential coefficient of linear thermal expansion 

9.20.1.9 Constraint Element Query 

This query returns information about constraints on load cases. The constraints are specified by constraint 

id in the “Constrrant ID(s)” input field, and the load cases are specified by selecting load case id(s) in the 

field “Load Case ID(s)”. 

For single point constraints the information displayed is: 

• Constraint_ID 

• Load Case_ID 

• Node_ID 

• CoordSys_ID 

• Freedom_Values - (typically x_translation,  y_translation, z_translation, x_rotation, y_rotation, 

z_rotation) 

9.20.1.10 Nodal Load Query 

This query returns information about applied loads on nodes in load cases. The nodes are specified by 

node id in the “Node ID(s)” input field, and the load cases are specified by selecting load case id(s) in 

the field “Load Case ID(s)”. The information displayed is: 
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• Load_Case_ID 

• Node_ID 

• CoordSys_ID 

• Load Type 

• Freedom_Values - (typically x_translation,  y_translation, z_translation, x_rotation, y_rotation, 

z_rotation) 

9.20.1.11 Displacement Query 

This query returns information about displacements of nodes in load cases. The nodes are specified by 

node id in the “Node ID(s)” input field, and the load cases are specified by selecting load case id(s) in 

the field “Load Case ID(s)”. The information displayed is: 

• Load_Case_ID 

• Node_ID 

• CoordSys_ID 

• Freedom_Values - x_translation, y_translation, z_translation, x_rotation, y_rotation and 

z_rotation 

9.20.1.12 Stress and Strain Query 

This query returns information about stress and strain of elements in load cases. The elements are 

specified by element id in the “Element ID(s)” input field, and the load cases are specified by selecting 

load case id(s) in the field “Load Case ID(s)”. The information displayed is: 

• Load_Case_ID 

• Element_ID 

• Variable – Either stress or strain 

• CoordSys_ID 

• Locations 

• Values – if variable is stress: σ11, σ12, σ13, σ22, σ23, σ33 and if variable is strain: ε11, ε12, ε13, 

ε22, ε23, ε33. 

9.20.1.13 Element Forces from Node Force Balance Query 

The query keys are Element ID and Load Case ID.  The information displayed is a table with the 

following columns:  

• Element ID 

• Node ID 

• Load Case ID 

• Coordinate System 

• Degree of Freedom. 

The table will have one row for each node of each specified load case and each specified element. 

9.20.1.14 Displacement Survey 

The query keys are Node ID and Load Case ID range, and a selection of maximum or minimum.   

For each node the survey reports the maximum or minimum displacement vector value in each 

component direction (x, y, z, rx, ry, rz) and resultant displacement value (sqrt(x*x+y*y+z*z)) for a 

single or range of node IDs, for a range of load cases.   
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For each node, the information displayed is the same as for the Displacement Query, but repeated seven 

times for the node, once for each component of the displacement vector, and once for the 

resultant.  Each repeated displacement vector component output line shall have the component that is 

the maximum or minimum underlined, and the corresponding Load Case ID output in the Load Case ID 

column. 

9.20.1.15 Stress or Strain Survey 

The query keys are Element ID and Load Case ID range, and a selection of maximum or minimum.   

For each element the survey reports the maximum or minimum stress or strain tensor value appropriate 

for the element type, the principle stress, and the Von Mises stress for a single or range of element IDs, 

for a range of load cases.  

For each element, the information displayed is the same as for the Stress or Strain Query, repeated as 

many times as there are components in the stress or strain tensor for that type of element.  Each 

repeated stress or strain tensor component output has the maximum or minimum component 

underlined, and the corresponding Load Case ID output in the Load Case ID column. 

9.20.1.16 Element Forces from Node Force Balance Survey 

The query keys are Element ID and Load Case ID range, and a selection of maximum or minimum.   

For each element the survey reports, for each node in the element, the maximum or minimum force 

vector component in each component direction (x, y, z, rx, ry, rz) and the resultant translational load 

value (sqrt(x*x+y*y+z*z)), for a single or range of element IDs, for a range of load cases.  

For each element, the information displayed is the same as for the Element Forces from Node Force 

Balance Query, repeated for each of the component directions and the resultant, repeated for each of 

the nodes in that type of element.  Each repeated force vector component output has the maximum or 

minimum component underlined, and the corresponding Load Case ID output in the Load Case ID 

column. 

9.20.2 Browse Composites 

AP209 P21-files with composites data may be imported into the database using the New file/Upload 

menu item or by drag and drop (see chapter 9.14.1). Composites consist of laminate tables that are 

assigned to a part/product and that list plies and their properties. The Browse Composites function 

presents the composites data of the imported AP209 file in a pop-up window. Figure 113 shows an 

example of only a single part/product that has laminate tables. 

 

 

Figure 112. Composites pop-up window 

Figure 113 shows the same query result where the details are shown after pressing the plus sign in the Id 

column of part/product and laminate table. 
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Figure 113. Composites pop-up window 2 

 

In the upper left corner one can see an Export-button. By pressing this button, a file output dialog is 

opened, and the composites data is exported to the selected file in XML format. In Figure 114 the data 

from the screen above is shown in XML format. 
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Figure 114. Composite information exported as XML 
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9.21 Comparison of product shapes 

9.21.1 Alignment of models 

The VCollab Presenter in EDMopenSimDM offers functionality to align two models by graphical 

interaction. This is performed as a (up to) 3 step approach where: 

1. Model A is translated to Model B 

2. An axis in Model A is aligned with an axis in Model B 

3. A plane in Model A is aligned with a plane in Model B. 

In each step, one point is selected from each model; these points are brought into the same location, axis 

or plane. 

The Align Models method is available from the VCollab Presenter menu, see Figure 115. 

 

Figure 115 VCollab Align models form 

The form shows the three steps to be performed. The first selected point is P1 under Align position, and 

the next one is P2. The step is applied by clicking Apply. The next selected point is P3, and so on until 

all three steps are applied. In some cases, models are aligned correctly after steps 1 or 2. The form can 

be closed any time. Steps can be undone by Undo (CTRL+Z). 

9.21.1.1 Example 

This example demonstrates the model alignment functionality of the VCollab Presenter. 

Two models must be loaded from the EDMopenSimDM PBS into the viewing pane, for example, by 

double-clicking on files with a cax-representation. In Figure 116, two models of the same product and 

with similar dimensions are loaded; they are not aligned. 
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Figure 116 Alignment example - Initial models 

1. Translating Model A to Model B (Figure 117) 

a. Point 1A on Model A, and Point 1B on Model B are selected 

b. Model A is moved along the vector from Point 1A to Point 1B 

  

Figure 117 Alignment example - Step 1 - Translation (before and after) 

2. Aligning an axis on Model A to an axis on Model B 

a. Point 2A on Model A, and Point 2B on Model B are selected 

b. Axis A (Point 1A to Point 2A) is aligned to Axis B (Point 1A/1B to Point 2B) 
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Figure 118 Alignment example - Step 2 - Axis alignment (before and after) 

3. Aligning a plane on Model A to a plane on Model B (Figure 119) 

a. Point 3A on Model A, and Point 3B on Model B are selected 

b. Plane A (plane defined by Axis A and Point 3A) and Plane B (plane defined by Axis A 

and Point 3B) are aligned 

  

Figure 119 Alignment example - Step 3 – Plane alignment (before and after) 

9.21.2 Export of measurements 

The VCollab Presenter offers a point to point distance measurement method from the VCollab Presenter 

menu item Measure > Distance or from toolbar button . 

This method will activate the distance measurements tool. It allows to measure distances between every 

two selected points within the same, or across different models. The measurements will be displayed 

with a line and label. The label may be edited after double-clicking. 

Figure 120 shows two loaded models with three sets of measurements. 
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Figure 120 Measurement labels in VCollab Presenter 

The measurements can be exported via the Presenter menu item Measure > Export to CSV. The resulting 

file looks like shown in Figure 121. The following details are listed in the file: 

- Measure name  – the measurement label 

- Measure value  – the distance 

- Model name 1 and 2  – the model name of the first point, and the model name of second point 

- Node ID1 and ID2  – if the model contains nodes with IDs (such as for FEM meshes) the 

node IDs are shown. If not (such as CAD models), NA is displayed. 

- X1,Y1,Z1,X2,Y2,Z2  – the coordinates of the points 

 

 

Figure 121 Resulting file from Measure > Export to CSV 
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9.21.3 Model properties 

Model properties can be calculated for AP209 models that include shape data. This includes Shape 

definition folder types (children of Design folder) and Analysis folder types (children of Analyses folder), 

in addition to models imported via New File > Upload if the uploaded file was converted to AP209. 

The functionality is available as Calculate model properties from the context menus of these folder types 

and of .stp files. 

When selecting this method, the result is stored as a file named model_properties.txt as a child of the 

selected folder. 

For CAD models the following information is calculated: 

- Model surface area  – The total area of the outer surface of the model 

- Model volume  – The total internal volume of the model 

- COG (volume)  – The center of gravity of the model (taking into account only volume and 

not mass). 

For analysis models the following information is calculated: 

- Surface element area – The total area of all surface elements in mesh 

- Model volume  – The total volume of all volume elements in the mesh 

- COG (volume) – The center of gravity of the model (taking into account the volume but 

not mass) 

- COG (mass)  – Similar to COG (volume) but also taking into account the mass density  

of element material. 

9.22 Link files and folders to folder 
It is possible to create links (references) to folders and files. This is done by using Drag-and-drop 

functionality in the following way. 

Note: A copy of the “PS browser” panel could be opened in the opposite panel container to support drag-

and-drop. Use “Show PS copy” tool bar button on the “PS browser” panel. 

Select and drag either a folder or a file and drop it into the desired target folder (“Tree” or “Details” 

view). A dialog to create the file reference appears (see Figure 122). 
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Figure 122. “File reference” dialog 

The text box “Name” is set with file name by default. The name of file reference could be changed. 

“Description” and “Comment” fields are optional and may be omitted. 

As result a file link icon is placed into the folder that the file was dragged into. 

When a folder reference is created, the following dialog appears (see Figure 123). 
 

 

Figure 123. “Folder reference” dialog 

The “Description” field is optional and may be omitted. 

As result folder link icons are placed into both the source and the target folder so that a two-ways link 

becomes available. 

9.23 Collections 
Folders and their data can be grouped into collections of the following three types: 

- Baseline 

- In-work package 

- LOTAR Archive. 

These are explained in the sub-chapters below. Table 2 displays the principle differences. 

Table 2. Differences in types of folder collections 

 Validated Approved Contiguous Export 

Baseline - X - X 
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 Validated Approved Contiguous Export 

In-work package - - - X 

LOTAR Archive X X X X 

 

LOTAR Archives shall be contiguous, that is, they shall be connected by parent-child relationships or 

parent-parent relationships.  

The collections sub-menus are only available in the context menu of the top product structure folder; see 

Figure 124. 

 

Figure 124. Three collection type sub-menus in top folder context menu 

 

All three types of collections become available for export after having been created (see menu item 

“Export to archive...”, 9.10). Baseline and LOTAR Archives require final approval, which will turn them 

into read-only collections. Only LOTAR Archives must be validated, that is, the STEP-files in such 

archives shall have successfully passed the “Validation>Validate...” function for “Full validation” (see 

9.14.6). 

Note: As long as a LOTAR archive has not been exported, yet, its final approval may be reverted. After 

export this will not be possible any more, and the archived branch will stay read-only. 

9.23.1 Baselines 

A baseline is a single folder or a set of folders that can be used as a basis for comparison during a 

development process of a product structure. A baseline may also be established as the basis for 

subsequent engineering activities. Such activities may be attributed with formal approval. 

9.23.1.1 New baselines 

Baselines are created by an administrator and from the product structure context menu only. Selecting 

the “New baseline…” menu item opens a panel that replaces the product structure panel for the time of 

defining the baseline; see Figure 125. 
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Figure 125. The baseline creation panel 

 

A baseline shall be contiguous. It will always include the product structure folder, which will become 

the direct parent of the start folder of the baseline. 

Only folders with “Final approval” can be included in baselines. The names of such folders are 

written in italic in the baseline panel, whereas folders that can not be selected are shown in grey. 

Folders for inclusion into the package are selected by clicking in the tickbox to the left of each folder. A 

baseline structure may start at any folder. Subfolders are automatically selected and can not be deselected.  

A baseline shall be given a name and may be given a description. 

As soon as a baseline is created its name becomes available in the menu items “Baseline>Show” and 

“Baseline>Remove”. 

9.23.1.2 Show baseline 

Baselines may be reviewed from the product structure context menu only and by any user with read 

access. A new product structure panel is opened to display the selected baseline; see left panel in Figure 

126. The baseline has read-only access for all types of users that are assigned to the owning product 

structure. 
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Figure 126. “Show baselines” opens another product structure panel on the left side 

 

9.23.1.3 Remove baseline 

Baselines can only be deleted by an administrator and from the product structure context menu only. 

After having selected a baseline for removal you are asked for a confirmation; then all traces of it will 

disappear from the system. 

9.23.2 In-work package 

An in-work package is a single folder or a set of folders that are collected into a zipped package for 

• back-up, 

• data exchange, 

• re-use. 

An in-work package is in principle not different from a baseline (see 9.23) except that the items in an in-

work package do not need to fulfill any requirements, such as validation and approval. On the other hand 

an in-work package can neither be treated nor converted into an official archive.  

9.23.2.1 New in-work package 

In-work packages may be created by any editor and from the product structure context menu only. 

Selecting the “New In-work package…” menu item opens a panel that replaces the product structure 

panel for the time of defining the in-work package; see Figure 127. 

An in-work package shall be contiguous. It will always include the product structure folder, which will 

become the direct parent of the start folder of the in-work package. 
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Folders for inclusion into the package are selected by clicking in the tickbox to the left of each folder. 

An in-work package structure may start at any folder. Subfolders are automatically selected and can not 

be deselected.  

 

Figure 127. Creation of an In-work package 

 

An in-work package shall be given a name and may be given a description. 

As soon as an in-work package is created its name becomes available in the menu items “In-work 

Package>Show” and “In-work Package>Remove”. 

9.23.2.2 Show in-work package 

In-work packages may be reviewed from the product structure context menu only and by any user with 

read access. A new product structure panel is opened to display the selected in-work package; the 

appearance is similar to “Show baseline” in Figure 126. 

9.23.2.3 Remove in-work package 

In-work packages can be deleted by any editor (or only the owner?) and administrators. The function is 

available from the product structure context menu only. After having selected an in-work package for 

removal you are asked for a confirmation; then all traces of it will disappear from the system. 

9.23.3 LOTAR Archive 

A LOTAR Archive is a single folder or a set of folders that are ready for export to an archive. The folder 

or branch needs to be finally approved (see 9.7.3) and all STEP-files need to have completed full 

validation successfully (see 9.14.6).  

9.23.3.1 New LOTAR AIP 

LOTAR archival information packages (AIP) may be created by administrators and from the product 

structure context menu only. Selecting the “New LOTAR AIP…” menu item opens a panel that replaces 

the product structure panel for the time of defining the LOTAR AIP; see left panel in Figure 128. 

A LOTAR AIP shall be contiguous. It will always include the product structure folder, which will become 

the direct parent of the start folder of the archived branch. 
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Folders for inclusion into the package are selected by clicking in the tickbox to the left of each folder. A 

LOTAR AIP structure may start at any folder. Subfolders are automatically selected and cannot be 

deselected.  

 

Figure 128. Creation of a LOTAR AIP 

 

A LOTAR AIP shall be given a name and may be given a description. 

As soon as a LOTAR AIP is created its name becomes available in the menu items “LOTAR 

package>Show” and “LOTAR package>Remove”. 

9.23.3.2 Show LOTAR AIP 

LOTAR archival information packages may be reviewed from the product structure context menu only 

and by any user with read access. A new product structure panel is opened to display the selected in-

work package; the appearance is similar to “Show baseline” in Figure 126. 

9.23.3.3 Remove LOTAR AIP 

LOTAR archival information packages can only be deleted by the owner and by administrators. The 

function is available from the product structure context menu only. After having selected a LOTAR 

archival information package for removal you are asked for a confirmation; then all traces of it will 

disappear from the system. 

9.24 Find 
The “Find”-function helps you to retrieve items from the EDMopenSimDM server that match a given 

text string. The function is triggered from the product structure top folder context menu and will open a 

panel of its own aside the product structure panel (see Figure 129). 
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Figure 129. Example of a “Find”-operation 

 

The topmost input field "Find text pattern" is for specifying the search pattern. Previous text patterns can 

be selected from the drop down list. New text pattern is added to the drop down list each time button 

"Find" is clicked. 

The following wildcards may be used in the “Find text pattern” field: 

Table 3. List of wildcard options for the Find... function 

@ - Matches any letter 

^ - Matches any upper case letter 

? - Matches any character 

& - Matches reminder of string 

# - Matches any digit 

$ - Matches a substring terminated by a space character or end-of-string 

* - Matches any number of characters 

\ - Begins a pattern escape sequence 

! - Negation character (used with the other characters). 

Note: These are the wildcards defined in ISO 10303-11, the EXPRESS reference manual. 

Wildcard options are treated as normal characters when "Exact match" is checked. 

The "Case sensitive" check box allows to specify case sensitive search criteria. If checked and you look 

for something that is written in uppercase, it will not be found if you state the search pattern in lowercase 

and vice versa. 

If "Latest version" is checked, search will be performed only within the latest version of each folder. 

Search can be restricted to selected attributes from the "Attributes" drop down list. One or more attributes 

can be selected (marked by tick box). 
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• Name - The name of an item in a breakdown structure (such as folder, attached file, person, ...) 

have name. 

• Description - The description of items of a breakdown structure. 

• File link - The original file path of a file attached to a folder (see Figure 45). 

• File extension - The extension of an attached file; for example: .docx, .pdf, ... 

• EXPRESS schema name - The name of the EXPRESS schema that a STEP-file complies to; for 

example: 

AP209_MULTIDISCIPLINARY_ANALYSIS_AND_DESIGN_MIM_LF. This applies to 

attached STEP files only. 

• Folder id - The folder unique identifier; this value is not represented in GUI. 

• Folder version – The identifier of a folder version, such as "1", "2", "3", ... 

• Person login - The user login credentials. 

• Property default value - The default value assigned to a property; see "Default value" in 9.9.1. 

• PDI OS - The operating system requirements of a file: see "OS" text field in Figure 45. 

• PDI original name - The original name of a file when it was uploaded. See "original name" text 

field in Figure 45. 

• PDI original format - The original name of a file when it was uploaded. See "original format" 

text field in Figure 45. 

The matching occurrences will be listed below the input form. Each occurrence has a “Show”-button. 

Clicking on this will open the product structure at the location of this occurrence. 

"Case sensitive" check box allows to specify case sensitive search. If you look for something that is 

written in uppercase, it will not be found if you state the search pattern in lowercase and vice versa. 

When "Last version" is checked, search will be performed among latest versions of each folder. 

 

Search operation can be even further constrained by using the advanced options that are shown when you 

click the clicks "Advanced" button (see Figure 130). 

 

Figure 130. Advanced options for Find functionality. 

Search can be performed within a branch rather than in the entire product structure. The branch (folder 

name) can be selected from the "Look in" drop down control. 

In addition, time intervals of changes (changed before and changed after) can be specified. 
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Latest editors (one or more) can also be specified so that search result will only contain items that have 

been edited (last update) by specified users. 

Search results may include only items of specified types that are selected in the "Object types" drop down 

control. For example, "PART", "DESIGN" and "ANALYSIS" are folder types; thus, search results will 

contain folders of those types only. 

Person, Organization, Approval and Property items are defined in the top folder and may be assigned to 

sub-folders in the product structure. All assignments of those items (regardless of the search criteria) can 

be shown as sub items of a search result that includes these items. Select the item you want to find 

assignments of by clicking into the “Show assignments” box in the corresponding line of the results 

listing. Then click the "Show assignments" button. The “Advanced” window will pop-up (see Figure 

130) and will allow you to constrain your search further. When you click “OK” in this window, the 

window will close and the search starts. The result will be listed under the header “Assignments” right 

under the selected line(s) of the original results listing. 

 

 

Figure 131. Show assignments 

9.25 Import local folder 
The functionality allows to upload selected local folder and all its content (subfolders and files) to product 

structure in one go. 

When "Import local folder..." context menu is clicked, the following dialog is appeared. 

 

Figure 132. Import folder dialog 

• Root folder - local folder to be imported 
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• Folder type - all folders will have selected type in product structure 

• Comment - optional. Some words about reason of the import may be given. 

Import procedure starts when "OK" is clicked. Note, import may take more than 1 minute. It depends on 

total size of files in selected folder. 

10 Local file explorer 
This panel represents the file structure on the local client machine as a tree. It is possible to Drag-and-

drop files between “Local file explorer” and “Product Structure browser” panels. 

Note: The “Windows Explorer” application can be used instead of the “Local file explorer” panel. But it 

is only possible to drag one (or several files) from “Windows Explorer” and drop it into the “Product 

Structure browser” panel, not vice versa. 

11 Help panel 
The panel contain two options: 

• “About” – opens window with information about application version and contacts 

• “Open reference guide” – opens web-page with the user manual. 

12 Email notifications 
SimDM persons (organizations) may have email assigned. Person (organization) will be notified about 

changes in a product structure if person (organization) is subscribed to email notifications. 

Note: A person may be given different e-mails in different product structures. 

Subscription can be done in any folder except the top-folder. So, there is no way to subscribe to changes 

in the entire product structure in one go. 

12.1 Subscribe to notification 
Select a folder, open context menu and select "Subscribe to notification..." menu item. 

 

Figure 133. Subscribe to notification menu item 

The following dialog appears (see Figure 134). 
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Figure 134. Subscribe to notification dialog 

Available person or organization should be selected in the "Person or organization" drop down list. 

Notifications have following types 

• Deep notification - notification is sent if something in the selected branch (selected folder and its 

children) is changed 

• Shallow notification - notification is sent if something in the selected folder (children folders are 

excluded) is changed 

Default name can be changed. 

Email subject and message should be given. 

13 Geometry and FEA viewer 
The “EDMopenSimDM viewer” panel (see Figure 137) displays the 3D model of one or several uploaded 

files. The panel is opened and closed by the main menu item View>Viewer panel. The VCollab Presenter 

application provides the viewing capability. 

AP203, AP209, AP214, AP242 and NASTRAN files (bdf and op2) are during upload automatically 

converted to the VCollab visualization format CAX. Both the source file and the CAX file are stored in 

the database; they can be downloaded individually. Only data sets of the following ISO 10303 

Application Protocol (AP) schemas are recognized and converted to CAX: 

AP203_CONFIGURATION_CONTROLLED_3D_DESIGN_OF_MECHANICAL_PARTS_AND_

ASSEMBLIES_MIM_LF 

AP209_MULTIDISCIPLINARY_ANALYSIS_AND_DESIGN_MIM_LF 

AP242_MANAGED_MODEL_BASED_3D_ENGINEERING_MIM_LF 

AUTOMOTIVE_DESIGN 

STRUCTURAL_ANALYSIS_DESIGN 

The version information that may follow these file names in curled brackets “{...}” is ignored. 

The following error situations may occur when a STEP P21-file is added (attached) to a folder; the last 

three error situations in the list below apply also to NASTRAN files. 
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Note: A STEP P21-file is identified by file extension .stp (lower or upper case letters are valid). 

 

• If the file has syntax errors and, thus, is not a valid P21-file, it will anyhow have been uploaded 

and will be accessible through the client. However, the message in Figure 135 will appear and 

will allow the user to read and retrieve the log-file of the import process: 

 

Figure 135: Error message for STEP P21-file with invalid syntax 

 

• A valid VCollab license needs to be installed on the server machine. If this license has expired or 

is missing, the client displays an error message informing about the license issue. No .cax-file 

will have been produced. 

• VCollab uses the EDM software development kit for its converter. If the EDM SDK license has 

expired or is missing, the client again displays an error message informing about the license issue. 

CAX file is not appear. No .cax-file will have been produced. 

• If the VCollab converter returns an error or has terminated, the message in Figure 136 will appear. 

This will, for example, happen when the file does not include geometry, but only load cases. The 

uploaded file will anyhow have been uploaded and will be accessible through the client; no .cax-

file will have been produced. 

 

Figure 136: VCollab error message at unsuccessful conversion to .cax-format 

 

The viewer is launched when you open (“Open” context menu) any of the above mentioned types of 

STEP-files. VCollab Presenter controls become available for manipulating the 3D model. 

You may specify a different viewer in the main menu item Tools → File associations. 
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Figure 137. “EDMopenSimDM viewer” panel 

 

Note: CAX files that are uploaded by you (vice automatically generated) and then opened will not be 

shown in the Viewer panel, but by the application that is associated with the CAX extension. 

14 Correlation plots 
The AP209 FEM Test correlation tool is an application for inspecting and plotting analysis and structural 

test results.  

14.1 Starting AP209 FEM Test Correlation 
From the context menu of a product_under_test node in the product breakdown structure, Correlation 

tool can be selected to start the application. 
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Figure 138. How to launch the Correlation Tool 

14.2 Prerequisites before launching 
Before running the correlation tool, the following should already have been performed: 

• Import gage definitions (see 9.15.4.5) 

• Create test definition (see 9.15.4.6) 

• Import test results (see 9.15.3.5) 

If this has been done, the structural test model should contain sensors, tests and test result. The model 

also has an association to an analysis model. 

14.3 Overview 
The application is divided into 5 sections: 

• Structural testing  

o Overview of sensors in model  

o Allows plotting of test results 

• FEA 

o Query functionality for elements and nodes 

o Allows plotting of analysis results 

• Correlation 

o Displays sensor to element or node associations 
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o Query functionality for elements and nodes 

o Query functionality for finding nearest elements and nodes 

o Allows plotting of test and related analysis results for correlation analysis 

• Legend 

o Overview of currently plotted items 

o Displays information of each plotted item 

• Plot area 

o Displays the plotted data 

 

 

Figure 139. Correlation Tool - layout of the user interface 

 

14.3.1 Structural testing 

14.3.1.1 Tree structure 

When the application is launched a content summary of the structural test model is presented in a tree 

view: 
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Figure 140. Correlation Tool – product tree of structural test model 

 

For every structural test product in the model, a top node will be shown. In most use-cases this will only 

be one. 

The tree view is then structured as follows: 

ü Structural Test Product 

ü Structural Test Case 

ü Sensor Type 

ü Sensor 

ü Sensor component 

Note that the sensors presented in the tree view, are sensors used in test, meaning that the same sensors 

may appear under multiple tests. 

The range dropdown box shows the type of result the current selected sensor component has. If there are 

multiple result types, the desired type can be selected. 

The domain dropdown box shows the type of domain (the x-axis data type; i.e. time, or frequencies). If 

there are multiple types, the desired type can be selected. 

14.3.1.2 Plotting 

To plot the result data of a sensor component, select a sensor component and press Add to plot. 

The data will be plotted in the Plot Area and an entry will be added to the legend with additional 

information of the sensor and sensor component. 

The sensor component results are plotted against the domain data selected from the domain dropdown 

box. 
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14.3.2 FEA 

14.3.2.1 Element and node overview 

In this section, the user may select a load case from the load case dropdown box. There are two tabs, one 

for nodes and one for elements. Selecting Element will allow the user to add elements to the element 

overview by element and face ID input. By selecting the Node tab, a different table will show up and the 

user may add nodes by node ID. 

 

Figure 141. Correlation Tool – overview of finite elements 

 

For every element added by the user, an entry will be created in the element list. 

The following details of the elements are displayed in the list: 

• Element ID 

• Face ID 

• dir.x  : The direction of element x-axis in the global frame of reference 

• dir.z  : The direction of element z-axis in the global frame of reference (Element normal) 

• pos  : The position of the element center in the global frame of reference 

• type   : The type of the element as: 

-  [<element shape>][<element order>][<AP209 entity type>] 

For every node added by the user, an entry will be created in the node list. 

The following details of the elements are displayed in the list: 

• Node ID 

• CSYS  : The ID of the nodes coordinate system 

• Local pos : The local position of the node (the position within the coordinate system it is 

defined in) 

• Global pos : The global position of the node. 

NOTE: Global position is currently not implemented in this table. Global positions are set when 

adding nodes to the node table in the Correlation part. 
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14.3.2.2 Load Case 

The top dropdown box in the FEA sections allows the user to select a load case from the Analysis Model. 

All load cases are found here, regardless if they have a relation to a test or not. 

14.3.2.3 Element and node input 

If the element tab is selected, two input boxes allow the user to choose and element ID (left) and face ID 

(right).  

For surface elements, a top surface is represented by 1 and bottom surface by 0.  

NOTE: Support for volume and curve elements is not implemented in this version of the correlation 

tool. 

 

If the node tab is selected, one input box allows the user to choose a node ID. 

 

Pressing Add will find the respective element face or node and add it to the list. 

Pressing Clear will clear the element or node list. 

14.3.2.4 Result type 

The available result types are: 

• Strain xx  : the x component of the element strain tensor 

• Strain yy  : the y component of the element strain tensor 

• Strain xy  : the xy component of the element strain tensor 

• Temperature  : the temperature at a node or element face 

• Displ.x  : the x component of nodal displacement 

• Displ.y  : the y component of nodal displacement 

• Displ.z  : the z component of nodal displacement 

• Displ.magnitude : the magnitude of nodal displacement 

• rot.x   : the x component of nodal rotation 

• rot.y   : the y component of nodal rotation 

• rot.z   : the z component of nodal rotation 

• rot.magnitude : the magnitude component of nodal rotation 

 

The list of available result types in the dropdown box always include all types listed above. However, if 

the result can be plotted depends on if they are available in the model or not. If no result exists for the 

specific result type and error message is given, 

 

NOTE: The result dropdown box is the same weather the element or node panel is selected. However, 

some are only implemented for nodes, and some only for elements. An error message is given if a 

result type is not implemented for the item to be plotted. 
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14.3.2.5 Individual checkbox 

Checking the individual checkbox before plotting, generates one plot for each element or node listed in 

the table. Leaving it unchecked, averages the results and creates one plot. 

14.3.2.6 Plotting 

Plotting of element or node results is done by clicking Add to plot.  

The data will be plotted in the Plot Area and an entry will be added to the Legend with additional 

information of the element or nodes. 

 

For  results from a static load case (one result value)  the results are plotted with a default domain type 

(without any name, but representing load factor).  This results in a linear plot line: 

• from x=0.0   with result value (y)=0.0  

• to x=1.0  with result value (y)=  the result of the element or node. 

For such static results, two slide bars will appear in the Legend area (Figure 142). 

 

 

Figure 142 Sliders for static results 

The slide bars are unique per load case plotted for, and not per individual plots in the load case. Scaling 

the sliders will move the start and end x (domain) values the results of the load case are plotted for. This 

can be used to align correctly with test results which may be plotted for arbitrary time series. 
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14.3.3 Correlation 

The concept of correlation is here meant as plotting structural test data from sensors together with related 

analysis results at the same location as the sensor. 

 

 

Figure 143. Correlation Tool – linking analysis and sensor data for plotting 

14.3.3.1 Setting up the correlation input 

The correlation tool only supports sensor components in the correlation section. 

Selecting a Sensor Component from the structural test tree view will automatically populate the input of 

the correlation section: 

- Test ID  : the test case ID of the selected sensor component 

- Load Case ID : the related Load case of the respective Test case 

- Sensor and sensor c.: the selected sensor component ID and the ID of its sensor 

- Element list   : elements related to the selected sensor component’s sensor 

 

Note: Relating load case and relating elements will only be filled if the Link check boxes are checked.  

14.3.3.2 Adding elements and nodes 

Similar as in the element and node tables in the FEA sections, elements and nodes can be added to a 

table. Here this can be done in two ways: 

• By specifying the element and face ID, or node ID and clicking Add. 

• By specifying a max distance, and max number of results, and clicking Add nearest. 

o This will search the model for nodes near the location of the sensor and add to the list the 

nearest nodes that are not further than max distance. Maximum number of nodes to add is 

restricted by the Max. res. input. 

o Note: when searching for nearest elements, the coordinates of the element centre is used. 

 



EDMopenSimDM™ Application Reference Manual, R17 

 

2022-06-01  Page 138 

 

14.3.3.3 Weighted distance average factor 

The plotted analysis results are based on a weighted distance average. 

 

The weighted average Swavg is calculated by:  

 

 

Where di is the distance between the ith element’s center to the sensor position, Si the tensor of ith 

element, dmax the maximum distance of all elements to the sensor position, and f the weigted distance 

average factor from user input. 

14.3.3.4 Plotting 

Pressing Add to Plot will plot both the sensor components results and the weighted average of the finite 

element results. 

Sensor component results are plotted as scatter plots. 

The plotted values of element and node results are transformed to match the orientation of the sensor 

component. If the results are from a static load case (one result value), the calculated value is scaled from 

load factor 0.0 to 1.0 and plotted as a linear curve. 

14.3.4 Legend 

The plot legend shows an overview of all plots currently in the plot area. 

 

 

Figure 144. Correlation Tool – specifying legend of plot representation 

14.3.4.1 Plot collection 

Each plot is put in a plot collection.  
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- For plots added from the Structural Test section, a plot collection is created for 

each different Test Case. 

- For plots added from the FEA section, a plot collection is created for each 

different Load Case. 

- For plots added from the Correlations section, a plot collection is created for each 

different Test Case + Load Case combination. 

14.3.4.2 Plot types 

Each plot has a top node (under a plot collection node) in the legend with an identifier and the type of 

plot. 

Type of plots supported in the prototype are: 

- Sensor Component plot 

- Element plot 

- Element group average plot 

- Correlation plot 

14.3.4.3 Plot details 

Each type of plots has different sub nodes displaying certain details of what was plotted. This includes 

sensor component direction, sensor type, element IDs, tensor values etc. 

14.3.4.4 Plot colour 

Each plot legend entry has a colour matching the plot colour. The colour can be changed from the context 

menu of the plot legend node. 

14.3.4.5 Plot style 

In the context menu of the legend entries of individual plots, the style context menu item can be used you 

change the style of the plot. The available styles are: 

• Line plot 

• Line/scatter plot 

• Scatter plot 

• Bar plot 

14.3.4.6 Removing plots 

Selecting a plot and pressing Remove will remove the plot entry and plot. 

Selecting a plot collection and pressing Remove will remove the complete plot collection. 

Pressing Clear will remove all plot entries and plots. 

14.3.4.7 Zoom fit 

Pressing Fit All will scale and zoom the plot axes to fit all displayed plots. 

From the context menu of a plot entry, selecting Fit to view, will scale and zoom the plot axes to the 

selected plot. 

14.3.4.8 Current domain and range 

Two dropdown boxes Domain (x-axis) and Range (y-axis) can be used to select which type of results 

are plotted. The plot area can show multiple plots, but only from of the same range and domain. If plots 
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of different range or domain have been added. These dropdown boxes allows the user to select which 

domain/range combination should be shown. When changing the dropdown box values, any plots that 

are not of that combination, will be hidden. The legends entry of the hidden plots are then set to light 

greyed shaded colour. 

14.3.5 Plot area 

The plotted values are plotted as strain vs load factor. 

 

 

Figure 145. Correlation Tool – plot example of strain vs load 

 

14.3.5.1 Plot interactions 

The following functions are available for navigating in the plot area: 

• Zooming 

o mouse scroll for standard zooming 

o hold mouse scroll and select area to zoom a specific area 

• Panning 

o left mouse click and hold 

• Fit to view: 

o See 14.3.4.7 

• Removing plots: 

o See 14.3.4.6 

• Colours 

o See 14.3.4.4 

 

15 Web client 
Some functionality of the desktop client is available from a web browser by the following URL: 
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http://localhost:8080/STM_web/?server=127.0.0.1&port=9090 

localhost means this computer. That is, localhost can be used when the EDMopenSimDM server is 

installed on the machine where you are going to use your web browser. 

The network name or IP address of the EDMopenSimDM server shall be used when accessed from 

outside. 

15.1 Authentication 
You have to provide your credentials (login and password) before you will be able to browse data. Put 

your login and password into the pop up form; see Figure 146. Note, always use "sdai-group" as value 

of the Group if prompted for it. 

 

Figure 146. Login form 

15.2 List of projects 
After successful authentication the list of available repositories and projects will be presented in the left 

side panel. An example of available product structures is shown in Figure 147. 

 

 

Figure 147. Available repositories and projects 

Click icon  near to the project name of your interest, and a context menu with the single item "Open" 

will appear. 
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Figure 148. "Open" menu item 

15.3 Product structure and meta-data 
The product structure of the project will be shown on the left side of the web page where repositories and 

projects were listed before. 

 

Figure 149. Product structure 

Children nodes are shown by clicking  or by clicking on node name. 

Meta-data of a product structure node is opened from the left panel by clicking the  icon and selecting 

"Open" menu item from the context menu; the result is depicted in Figure 150. 
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Figure 150. "Info" tab with meta-data 

 

Tab "Files" contains the list of files attached to a corresponding node. 

 

Figure 151. "Files" tab with meta-data 

Product structure nodes may be assigned user-defined property values. 

 

Figure 152. "Properties" tab data 

 

Click "OK" to start upload. After a while the uploaded file will appear in the "Files" tab. 

15.4 Download 
The content of a folder and all children below including their documents can be exported as a ZIP 

package. 
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Click  icon of a required node and select the "Download" menu item from the context menu. 

15.5 Add remark 
A folder can be commented, that is, a new remark may be added. 

Click  icon of a folder and then select the "Add remark" menu item from the context menu. 

 

 

Figure 153. Form to add a remark 

Give the subject for your remark and the remark itself. Then click "OK". 

15.6 Add approval 
A folder and all its underlying content can be approved (disapproved) by adding an approval tag to the 

folder. 

Click  icon of a folder and then select the "Add approval" menu item from the context menu. 

 

Figure 154. Form to add an approval 

Select the resolution type (approved, rejected or not applicable) and add a description. 

Then click "OK". 

15.7 Import folder (ZIP package) 
A local folder and all its content (including sub folders) can be imported to a selected node. This, 

however, requires that the local folder has been zipped first. 

Click  icon of a node and then select the "Import folder" menu item from the context menu. 
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Figure 155. Form to import folder 

Select "Folders type" item. All imported folder will be assigned this type. 

"Files types" may be empty. In this case the system will set the file type (for each file) according to the 

individual file extension. 

15.8  Export branch 
The selected folder and its underlying branch will be zipped as for the “Download” function, however, 

also files that are hidden from the user are included, such as, log-files and VCollab cax-files. The 

EDMopenSimDM management data for that share of the model will be added as P21-files, both for the 

EDMopenSimDM specific master model schema and for the AP209 schema.  

The exported file may be uploaded back into an instance of EDMopenSimDM to continue working with 

it. 

Click  icon of a required node and select the "Export branch" menu item from the context menu. 

15.9 Delete folder 
A folder can be deleted. That is, it can be removed from the product structure. 

Click  icon of a node and then select the "Delete" menu item from the context menu. 

 

 

Figure 156. Delete confirmation in Mozilla Firefox 
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